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Picarro Notices
Thank you for purchasing a Picarro product. Your Picarro system is a quality product that was designed 
and manufactured to provide reliable performance.

This User Manual  is an important part of your purchase as it will help familiarize you with the system and 
explain the numerous features that have been designed into it. Please read this manual thoroughly 
before using your Picarro system.

Please contact Picarro or your authorized Picarro distributor should you have questions regarding 
specific applications or if you require additional information.

DISCLAIMER AND RESERVATION OF RIGHTS

Picarro has prepared this manual solely for the information and use by its customers as a guide for the 
selection, installation, operation, and maintenance of the products described.

EXCEPT AS PROVIDED IN THE TERMS AND CONDITIONS OF SALE FOR PICARRO PRODUCTS, 
PICARRO ASSUMES NO LIABILITY WHATSOEVER, AND PICARRO DISCLAIMS ANY EXPRESS OR 
IMPLIED WARRANTY, RELATING TO SALE OR USE OF PICARRO PRODUCTS, INCLUDING LIABILITY 
OR WARRANTIES RELATING TO MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.

Picarro reserves the right to change or update the contents of this manual and the specifications of its 
products at any time, without notice. Picarro has endeavored to include information that is current and 
accurate as of the date of the publication or revision of this document, but Picarro does not guarantee 
that this document is error free or that it is accurate regarding any particular specification.

Picarro expressly reserves all intellectual property rights, including all intellectual property rights relating 
to any product described in this manual. This document does not grant any license, express or implied, 
by estoppel or otherwise, to any intellectual property rights of Picarro or any third party.

PATENTS

The products described in this manual are subject to Picarro patents and patents pending. Information 
about Picarro patents applicable to these products is available at www.picarro.com/company/patents

TRADEMARKS

  Picarro and the Picarro logo are trademarks of Picarro, Inc.
  Koolance® is a registered trademark of Koolance, Inc.

  Linux® is a trademark of Linus Torvalds.

  Molex® is a registered trademark of Molex LLC.

  RealVNC® is a registered trademark of RealVNC Limited

  SilcoNert® is a trademark of SilcoTek® Corporation.

  Snoop® is a registered trademark of Swagelok Company.

  Swagelok® is a trademark of Swagelok Company.

  TeamViewer ® is a trademark of TeamViewer Germany GmbH.

Copyright © 2025 Picarro, Inc. All rights reserved.

https://www.picarro.com/company/patents
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1 Introduction
The Picarro PI5131-i isotopic and gas concentration analyzer enables simultaneous 
measurements of site specific and bulk δ15N and δ18O in N2O. N2O is a potent greenhouse 
gas; a better understanding of emission sources can help to mitigate its adverse effects on 
the environment. Picarro provides a valuable solution for discerning and measuring the 
source of N2O emissions in real-time, both in the field and in the lab.

1.1   System Overview
This section provides an overview of the analyzer, related components, and specifications.

1.1.1 Analyzer
 The following figure displays the analyzer front and back panels. More detailed information 
on panel features, functions, and connections are in Chapter 4, Hardware Setup.

LED Status Indicator

USB Port

Vacuum Ports

Sample Inlet

Valve

Soft Power Button

Main Power

PC Communication Ports

Figure 1 - PI5131-i Front/Back Panels

1

2

3

4

5

6

7

8
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1.1.2 Front Panel Operating Status
The LED indicator on the front panel shows the current operating state of the analyzer. The 
following figure describes the status indicator states. The status states and colors are also 
linked to the System Alarm Panel on the CRDS Data Viewer Screen. See Section  .

Figure 2 - LED Status Indicator

1.1.3 A2000 Vacuum Pump
The A2000 vacuum pump is used to maintain cavity pressure inside the analyzer. The pump 
should be connected and running whenever the analyzer is in use.

Figure 3 - A2000 Vacuum Pump - Side Views

1.2   Analyzer Specifications

Table 1 - PI5131-i Specifications

Parameter Specification

Measurement Technique Cavity Ring-Down Spectroscopy (CRDS)

Primary Gases Measured  δ15N and  δ18O isotopes
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Parameter Specification

Weight: Analyzer

Weight: A2000 Pump

32.2kg (71 lbs.) – Should be lifted by two people.

6.5 kg (14.4 lbs) 

Dimensions - Analyzer

Length: 76.8 cm (30.25”)

Width: 42.3 cm (16.65”)

Width with Rack Mount Rails: 44.78 cm (17.63”)

Height: 22.23 cm (8.75”), 

Height with Feet: 23.5 cm (9.25”)

Dimensions – A2000 Pump

Length: 27.9 cm (11”)

Width: 10.2 cm (4”)

Height: 19.1 cm (7.5”)

Clearance Front: 15 cm (6”); Rear: 15 cm (6”)

Ambient Temperature Range
Operating: 15 °C to 35 °C (50 °F to 95 °F) 
Storage: -10 °C to 50 °C (14 °F to 122 °F)

Ambient Humidity Range < 99% RH non-condensing

Sample Pressure 300 to 1000 Torr (40 to 133 kPa)

Sample Flow Rate <50 sccm at 760 Torr, no filtration required

Maximum Altitude 3,048 m (10,000 ft – Operation)

Required Accessories
Included: Pump (external), 

Supplied by Customer: LCD monitor

Operating System Ubuntu 20 Linux

Data Outputs
RS–232, Ethernet, USB, Modbus, Data Streaming: 

Optional Analog 4–20 mA

Installation Benchtop or 48.3 cm (19”) rack mount

Power Requirements

Mains Supply Voltage Fluctuation

100 – 240 VAC; 50 – 60 Hz (auto-sensing) 250 W Max

150 W (pump) ±10% of the nominal voltage
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Parameter Specification

Minimum Rated Circuit Amperage
10A @ 115 VAC

5A @ 230 VAC

Liquid Ingress Protection None

1.3   Acronyms
This manual includes various acronyms. For definitions, see below: 

Table 2 - Acronyms, Formulas, Units, and Symbols

Acronym Definition

“ (as in 
1/4”)

Inches

°C degrees Celsius

% Percentage

± Plus–minus sign

< Less than

> Greater than

≤ Less than or equal to

≥ Greater than or equal to

A Ampere

AC Alternating Current

CDA Clean Dry Air

cm centimeters

CO2 Carbon Dioxide

COM Communication Port

CRDS Cavity Ring-Down Spectroscopy

CSV Comma Separated Values
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Acronym Definition

CPU Central Processing Unit

DC Direct Current

DIO Digital Input/Output

DVI Digital Visual Interface

°F Degrees Fahrenheit

ft. Length in feet;1 ft. = 12” or 12 inches (30.48 cm)

GUI Graphical User Interface

H2O Water, Water Vapor

HDF Hierarchical Data Format 

Hz Hertz

ID Inside Diameter (i.e., .5” ID) or Identification (i.e., Slave ID)

I/O Input/output

kg kilograms

kPa Kilopascal; unit of pressure; 1 kPa = 0.145 PSI

lbs pounds

LAN Local Area Network

m Meters or month

mA Milliampere

max Maximum

min Minimum

mm millimeters / millimetre

N/C No Connection

NC Normally Closed

NO Normally Open
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Acronym Definition

NTP Network Time Protocol

OD Outside Diameter

P Pressure

PC Personal Computer

PDF Portable Document Format

PFA
Perfluoroalkoxy – A chemically resistant polymer, suitable for use with sticky 
and aggressive gases

PN Part Number

ppb parts per billion

ppm parts per million

PSI (psi) Pounds per Square Inch

PSIG Pounds per Square Gauge

Pws Water vapor pressure

RH Relative Humidity

RJ-45 Registered Jack (physical network interface)

RS232 Recommended Standard 232 (serial communication protocol)

sec Seconds

SS/SST Stainless Steel

TEC Thermoelectric Cooler

TCP/IP Transmission Control Protocol/Internet Protocol

Torr Torricelli (unit of pressure equal to 1/760 atmosphere)

UM User Manual

USB Universal Serial Bus

UPS Uninterruptible Power Supply

VA Volt-Ampere
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Acronym Definition

VAC Volts Alternating Current

VDC Volts Direct Current

W Watts

WB Warmbox

1.4   Text Conventions
The following conventions are used in the manual.
 l Italic text identifies screen names and to emphasize important text or certain features.
 l Bold Italic text identifies section reference links.
 l Bold text is for actions to take (such as clicking on a UI button), caution and warning 

statements, and text you should type or select in screens.
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2 Safety
The following chapter provides an overview of warning symbols used in this document, 
general safety guidelines for using the analyzer, and acquired certifications.

2.1   Warning Symbols
The purpose of these icons is to provide a visual convention to alert you of important 
information. They indicate dangers to either the operator or to the product, and other 
important information. The following symbols are used in this manual.

DANGER indicates an imminently hazardous situation that, if not avoided, will result in 
death or severe injury.

WARNING indicates a potentially hazardous situation which, if not avoided, could result 
in death or severe injury.

HAZARDOUS VOLTAGE alerts user to areas that may expose a user to electrical energy 
that is high enough to cause injury or death.

LASER WARNING alerts user of a laser danger.

CAUTION alerts user of a potential danger to equipment or to the user.

HOT SURFACE alerts user to potential injury from hot surfaces.

DANGER

WARNING

WARNING

WARNING

CAUTION

HOT SURFACE
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The NOTE is important information to be aware of before proceeding.

REMINDER is a helpful hint for procedures listed in the text.

2.2   General Safety
This section describes the CDRH and CE certifications for class 1 lasers and regulatory 
conformity for the European Union.

2.2.1 CDRH Certification
This Picarro analyzer complies with 21 CFR Chapter 1, sub-chapter J, and is classified as a 
Class 1 laser system when all panels and covers are on.

2.2.2 CE Certification
This Picarro analyzer complies with the European standards and the instrument is affixed 
with a CE label. This CE label is located on the rear of the instrument.

Using this analyzer in a manner not specified by Picarro may result in damage to the 
analyzer and render it unsafe to operate

This analyzer is for indoor use only and has an ingress protection rating of IPx-0. 
Analyzer is not protected against exposure to water including dripping, spraying, 
splashing or immersion

Do not operate in an explosive atmosphere! Do not operate in the presence of flammable 
gases or fumes

NOTE

REMINDER

WARNING

WARNING

WARNING
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The analyzer contains no user serviceable components except the particulate filter, CPU 
fan, and A2000 vacuum pump diaphragms and valves. To order user-replaceable parts 
and access video replacement instructions, see section . 

Do not attempt repairs; instead, report all problems to Picarro Customer Support or your 
local distributor. Please contact Picarro if you have any questions regarding the safe 
operation of this equipment

Do not replace the mains supply power cord with an inadequately rated cord.

If mounting in a 19” rack, this analyzer cannot support itself using a front rack mount kit 
alone. It must be supported by a shelf, or by user-provided “L” type support brackets.

Equipment Damage: Exceeding gas inlet pressure or temperature specifications could 
result in damage to the instrument. In the case of higher input pressure or flow, 
configuring a sampling bypass manifold system is recommended.

Use a ‘tee’ at the gas inlet and exhaust the remainder of the gas stream appropriately.

The inlet gas connector on the back panel of the analyzer, and its immediate vicinity, 
runs hot during operation of the analyzer. Take care when connecting gas lines or 
working at the rear of the instrument to wear protective gloves or avoid contact with 
these surfaces.

CAUTION

CAUTION

WARNING

CAUTION

HOT SURFACE
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Equipment Damage: Do not disconnect the AC power to the analyzer, vacuum line, or 
the AC power to the external vacuum pump while analyzer is operating. Damage may be 
caused by current surges if power is applied while attaching or removing cables.

This analyzer weighs 71 lbs. (32.2 kg ). Use the technique described below when lifting 
the analyzer.

1. Before lifting, inspect the unit for slippery substances or sharp edges.

2. Lift with two people, one on each side of the analyzer.

3. Crouch down and stay close to the unit. Always keep your back as straight as 
possible. 

4. Position your feet for sturdy balance. Lift with your legs, not your back. 

5. Do not twist the back while carrying the unit. Rotate direction with hip joints. 

6. Lower the unit by bending at the knees.

2.3   Laser Safety

This equipment is classified as a Class 1 laser product with an embedded 3B laser in 
accordance with EN 60825-1:2014. Do not to open the enclosure where this label is 
placed; there are no user serviceable parts inside.

The following laser safety Label is affixed to the outer cover of the analyzer.

Figure 4 - Laser Safety Label – Affixed to Outside Cover of Analyzer

CAUTION

WARNING

WARNING



2 Safety

26 PN 40-0141, REV A PI5131-i User Manual

The laser is a Class3B when exposed. 
Only operate or service this device in accordance with the instructions in this guide, and 
only open the device in an approved laser safe service area using appropriate laser-
safety glasses.

The following laser safety label is affixed to the inside of the analyzer: 

Figure 5 - Laser Safety Label – Affixed to Inside of Analyzer

Use of controls or adjustments or performance of procedures other than those specified 
herein may result in hazardous radiation exposure.

Any light emitted from the front panel status indicator, regardless of color or state, 
indicates one or more lasers are on.

WARNING

WARNING

WARNING
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3 Unpacking

3.1   Unpack Components
While unpacking each shipping box:
 l Inspect each item to ensure it is not damaged. 
 l If items are missing, contact Picarro.
 l Keep the shipping materials to reuse when transporting the analyzer.
 l Contact Picarro for options on transporting systems to remote labs.

This analyzer weighs 71 lbs. (32.2 kg). Use the technique described below when lifting 
the analyzer.

1. Before lifting, inspect the unit for slippery substances or sharp edges.

2. Lift with two people, one on each side of the analyzer.

3. Crouch down and stay close to the unit. Always keep your back as straight as 
possible. 

4. Position your feet for sturdy balance. Lift with your legs, not your back. 

5. Do not twist the back while carrying the unit. Rotate direction with hip joints. 

6. Lower the unit by bending at the knees.

3.2   Contents

The following shipping contents may arrive in one or more shipping containers.

Table 3 - Shipping Contents

Part (qty) Description

Analyzer (1)

Includes all the data acquisition, control, and 
communications hardware and firmware to perform all gas 
handling, spectral collection, and analysis.

WARNING

NOTE
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Part (qty) Description

AC Power Cables (1)

A power cable with connectors appropriate to your country 
is provided. Note: The analyzer automatically adjusts to 
local voltage. 

Control Cable Kit (1)

For external solenoid valves.

Nut (1) and Ferrules (2)

For connecting input line to analyzer gas input.

Vacuum Hose (1)

Hose to connect the pump to the analyzer.

Rails (1 set)

Mounting rails for cabinet installation.

Keyboard and Mouse (1)

Monitor is not included.
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Part (qty) Description

Document Packet (1)

Includes this user manual and certificate of compliance (not 
shown).

Coolant (1)

1 bottle of Koolance 702 liquid coolant.

A2000 Vacuum Pump (1)

Provides vacuum required for sample gas sequencing into 
and out of the analyzer.

AC Power Cable (1)

A power cable with connectors appropriate to your country 
is provided. 

Note: The vacuum pump voltage must be selected. See  in 
section . 

Pump Manual (1)

Detailed instructions for pump.
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4 Hardware Setup
Read this entire section before proceeding. Refer to Figure 15 in the following section for 
installation.

4.1   Required Components and Tools
 l 9/16" open end wrench
 l 11/16" open end wrench
 l 5/8" open end wrench
 l Phillips head screwdriver (for rack mounting)
 l 2.5 mm Allen wrench (for rack mounting)
 l Pump
 l Power Cord for analyzer and pump

4.2   Installation Safety

Two-person lift required: The analyzer weighs 32.2 kg (71 lbs). When lifting the analyzer, 
use the technique described 2.2 General Safety (or follow your local regulations). 

When the analyzer is being integrated to an external system, the safety of that system is 
the responsibility of the assembler of that system. 

Equipment Damage: Do not attach electrical power to or start the analyzer until after 
attaching and turning on the External Vacuum Pump. Do not disconnect the vacuum line 
while the analyzer is running. Failure to do so could result in damage to the optics.

Picarro sells certain USB enabled devices, such as GPS, which are approved for use. Do 
not connect USB hubs or unauthorized USB devices (except flash drives, mice, and 
keyboards) to the USB ports. Unauthorized USB devices may interfere with the normal 
functioning of the analyzer.

WARNING

CAUTION

WARNING

WARNING
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When using compressed gases, follow all appropriate safety conventions, including use 
of eye protection, physical restraint of cylinders, etc.

Lines connected to the 1/4” Swagelok sample inlet connector must not exceed 15 PSIG 
of pressure.

Operating at concentrations above the intended ranges may render the instrument 
unsafe to operate, maintain, service or dispose of.

Any light emitted from the front panel Status Indicator, regardless of color or state 
indicates one or more lasers are on.

During installation, do not position the analyzer so that it is difficult to operate the 
electrical disconnecting device (such as an emergency off (EMO) switch or breaker).

If mounting in a 19” rack, this analyzer cannot support itself using a front rack mount kit 
alone. It must be supported by a shelf, or by user-provided “L” type support brackets.

Use the AC power cables supplied with the analyzer or a similarly rated cable. Check 
with Picarro technical support if you have questions about power cable replacement. An 
inadequately rated power cable can result in equipment damage.

WARNING

WARNING

WARNING

WARNING

CAUTION

WARNING

CAUTION
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Cords shall be rated for the maximum current for the equipment and the cable used shall 
meet the requirements of IEC 60227 or IEC 60245. Cords certified or approved by a 
recognized testing authority are regarded as meeting this requirement. The connector 
type used should be: IEC320 C13.

If the analyzer has been stored at less than 10 °C, allow the components to equalize to 
room temperature before starting the installation process.

Equipment Damage: It is imperative that the analyzer have adequate ventilation and/or 
cooling to maintain the ambient temperature below 35 °C when operating. Do not place 
the pump or the instrument in any enclosure without providing adequate forced air flow.

Do not plug or block any perforations in the chassis of the instrument. Do not put 
anything near the instrument that will impede the air flow. Failure to provide adequate 
airflow, especially clearance at the front and rear panels, to ensure proper airflow and/or 
cooling to the analyzer will result in overheating of the analyzer causing a shutdown and 
potential damage. There should be 6” (15 cm) of clearance in the front and back of the 
analyzer.

The coolbox pressure will need to be optimized if deployed at an altitude of < -150 m or 
> +1,500 m. Contact Picarro Customer Support.

CAUTION

CAUTION

CAUTION

CAUTION

NOTE
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To determine if the ventilation is adequate in an enclosure, monitor the temperature of 
the air near the instrument and adjust ventilation so that the ambient temperature is 
within specification. As a guide, the ambient temperature of the air around the 
instrument cannot exceed the specifications listed below.

Thermal 
Specifications

Min Max Description

Ambient Operating 
Temperature

15°C 35°C 
Worst-case environmental limits 
(unless otherwise specified)

4.3   Analyzer Preparation

4.3.1 Ventilation Considerations
The instrument and pump require adequate ventilation in order to function properly. Do not 
plug or block any perforations in the chassis of the instrument. Don’t place anything near the 
instrument that will impede the air flow. 

4.3.2 Positioning

The unit is shipped with rubber feet installed for benchtop use. Alternatively, it can be 
mounted in an equipment rack using the drawer-style rails included in the shipping 
crate. If the rails are used, the rubber feet must be removed so the unit can fit in a 
standard 5U rack opening. For instructions, see 4.5 Rack Mount Instructions

1. Remove the analyzer and the external vacuum pump from the shipping container.

2. Install the analyzer in a rack or place it on a cart or table.

If you rack-mount the analyzer, be sure to support it with a shelf or the provided rails; 
the analyzer cannot support itself on the front rack mounting brackets alone.

3. Place the external vacuum pump near the analyzer in a rack, or on a cart or table.

CAUTION

NOTE

CAUTION
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4. Unpack the analyzer accessories (vacuum line, cable kit, manual, and certificate of 
compliance).

Store the certificate of compliance in a safe place. It may be required if you contact 
Picarro for service or questions.

5. Remove the caps from the analyzer Sample inlet and Vacuum connection ports. 

6. Remove the caps from the pump vacuum inlet. Save the caps for reuse in case the 
analyzer and pump is stored, moved, or shipped.

4.3.3 Set A2000 Pump Input Voltage
1. If using an A2000 vacuum pump, set its input voltage to the correct level for your area by 

rotating the voltage selector switch located on the side of the pump next to the fuse 
holder.

Fuse

Input Voltage Selector

Figure 6 - Vacuum Pump Voltage Selection

4.4   A2000 Pump and Gas Inlet Connections
Follow instructions in this section when using an A2000 pump with your analyzer.

4.4.1 Pump Connections
Refer to the following figure when using an A2000 pump with your analyzer.

NOTE

1

2
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Figure 7 - Analyzer Setup with A2000 Pump

When working with hazardous gases, remove the pump exhaust muffler and adapt a 
tube to the vacuum pump exhaust port (shown in the above figure) and direct the 
exhaust to a safe place for venting the mixture of sample gases. For instructions, see 
Chapter G, Setting up Contained Exhaust Flow.

1. Connect the provided vacuum line between the analyzer port labeled VACUUM and the 
pump vacuum inlet. 

2. If working with hazardous gases, see Chapter G, Setting up Contained Exhaust Flow for 
instructions on directing the pump exhaust to a safe venting environment.

4.4.2 Sample Gas Inlet Connections 
There are two types of sample Inlet connections which are model-dependent. 
 l Analyzers that have stainless steel (SST) sample inlet connectors.
 l Analyzers that have PFA sample inlet connectors.

CAUTION
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4.4.3 Sample Gas Inlet Connection (SST Tubing)
1. Use 1/4” OD SST tubing and connector sets to connect from sample source to the 

sample inlet.

2. Place the two ferrules inside the nut as shown below.

Figure 8 - Orientation of Inlet Nut and Ferrules (SST Tubing)

3. Loosely connect the nut to the INLET on the back panel of the analyzer, being careful not 
to let the ferrules fall out.

4. Insert the tubing into the back of the nut and through the ferrules, feeding it in as far as 
possible without deforming the tubing.

5. Hand tighten the nut.

6. Using a 9/16" wrench (not included), tighten the nut 1-1/4 turns.

When reconnecting SST tubing

7. Inspect the ferrules. If you see any damage, replace the ferrules and follow the directions 
above for making a new connection.

8. If there is no damage, hand tighten the connector to the analyzer sample inlet.

9. Using a 9/16" wrench, tighten the nut 1/6 of a turn (60°).

4.4.4 Sample Gas Inlet Connection (PFA Tubing)

When making a new PFA gas inlet connection: 

1. Use 1/4” OD PFA tubing and connector sets to connect from sample source to the 
sample inlet.

2. Place the two PFA ferrules inside the PFA nut as shown in the following figure.

Figure 9 - Orientation of Inlet Nut and Ferrules (PFA Tubing)

3. Loosely connect the nut to the INLET on the back panel of the analyzer, being careful not 
to let the ferrules fall out.
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4. Insert the tubing into the back of the nut and through the ferrules, feeding it in as far as 
possible without deforming the tubing.

5. Hand tighten the nut.

6. Using a 5/8" wrench, tighten the nut 1-1/6 turns (1 full turn plus another 60°).

When reconnecting PFA tubing:

1. Inspect the ferrules. If you see any damage, replace the ferrules and follow the directions 
above for making a new connection.

2. If there is no damage, hand tighten the connector to the analyzer sample inlet.

3. Using a 5/8" wrench, tighten the nut 1/6 of a turn (60°).

4.5   Rack Mount Instructions
SI and PI series analyzers can be mounted in a standard 5U rack opening using slide rails or 
rack mount kit using additional shelf to support the weight of the analyzer. Use one the 
following procedures for the desired mounting configuration.

4.5.1 Rack Mount (Slide Rails)
Follow these instructions to mount the analyzer using slide rails.

1. Remove the rack-mounting rails from shipping crate and remove packaging.

2. Extend each rail. Press the blue PUSH HERE button and remove the narrow inner slide 
from the assembly.



4 Hardware Setup

38 PN 40-0141, REV A PI5131-i User Manual

Press to Release

Inner Slide

Figure 10 - Inner Rail Slide Removal

3. Attach the inner slide to side of the analyzer as shown in the following figure using four 
included M4 x 8 button-head screws.

4. Repeat on the other side of the analyzer.

Figure 11 - Attaching Inner Slide Rails to Analyzer

5. Attach a front panel restraint (locking bracket) to each side of the analyzer using two 
included M4 x 8 button-head screws.

1

2
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Front Panel Restraint

Figure 12 - Front Panel Restraint Installed

6.  Mount the outer rails to the rack using supplied hardware at each end, or according to 
rack design.

Figure 13 - Outer Rail Mounted to Rack

1
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Equipment racks vary, and some customization may be necessary.

7. Remove the rubber feet from the analyzer using a Phillips screwdriver. This may be 
necessary to prevent clearance issues with adjacent instruments within the rack.

Two-person lift required. This analyzer weighs 71 lbs (32.2 kg) When lifting the 
analyzer, use the technique described in the Safety section of this document (or 
follow your local regulations) .

8. Use two  people to lift the analyzer, engage the inner rails on analyzer with outer rails in 
rack, and slide analyzer into place. Then secure the front panel restraints (Figure 12) to 
the rack frame.

4.5.2 Rack Mount (Mount Kit)
Follow these instructions to mount the analyzer using the mount kit.

If mounting in a 19” rack, this analyzer cannot support itself using a front rack mount kit 
alone. It must be supported by a shelf, or by user-provided “L” type support brackets.

1. Using the mount kit, attach a front panel restraint (locking bracket) to each side of the 
analyzer using two included M4 x 8 button-head screws.

NOTE

WARNING

WARNING
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Front Panel Restraint

Figure 14 - Front Panel Restraint Installed

2. Install the additional user supplied shelf or "L" brackets to support the weight of the 
analyzer as recommended. 

3. Use two  people to lift the analyzer into place. Then secure the front panel restraints 
(Figure 12) to the rack frame

If needed, perform any additional steps to secure the analyzer per the user supplied 
support guidelines.

4.6   Electrical Connections 
 Refer to the following figure for connection points.

This section is designated as Electrical Safety Task Type 2: Equipment is energized. 
Energized circuits are covered or insulated.

1

NOTE

NOTE
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External Vacuum Port to Vacuum 
Pump

Gas Sample Inlet

Analyzer pressurized air inlet 
connection

Solenoid valve cable connection

On/Standby switch with indicator LED

4-20 mA Output screw terminal block

Rocker power switch

AC Line power receptacle

Ethernet Ports – RJ-45 (2 ea.)

 USB-2 Ports

 DVI-D Video Monitor Port

 Serial port for command interface 
(COM1)

 Serial port for streaming data (COM2)

 Ground binding post

 HDMI Port

 Display Port

 USB Ports (4 ea.)

 Audio In/Out Ports

Figure 15 - Rear Panel Diagram

1. Connect a monitor to the HDMI port at the back panel. The analyzer will detect the 
connection and adjust the resolution to match the monitor.

2. Connect a mouse and keyboard to a pair of USB ports.

3. Connect the provided AC power cable from the analyzer to the power source.

1

2

3

4

5

6

7

8

9

10
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12

13

14

15

16

17

18
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The analyzer has a universal power supply that automatically adjusts to power 
sources ranging from 100-240 VAC, 50/60 Hz, 10 A max.

The A2000 pump does not automatically adjust to power sources. If using the A2000 
vacuum pump, ensure its input voltage is set to the correct level for your area by 
rotating the voltage selector switch located on the side of the pump next to the fuse 
holder (see Figure 6).

4. Check that the A2000 pump voltage input switch is set correctly.

5. Connect the provided AC power cable from the vacuum pump to the power source.

6. If used, connect the valve cable from the analyzer back panel to any solenoid valves.

7. If used, connect rotary valve (A0311 or A0311-S) to COM2 with its provided serial cable.

4.7   Chiller Laser Cooling
A chiller with a 50 mL water buffer tank is installed for reliable and efficient laser cooling. 
Please note the following:
 l The coolant in the buffer tank is partially filled when shipped. Follow the instructions 

below before you begin measurements. 
 l Instrument must be powered off for water tube reconnection and water fill, refill, or drain.
 l Check and confirm the flowing movement of coolant every six months or whenever a 

disconnection and reconnection of the buffer tank occurs.
 l Inspect the water level in the reservoir every six months; add or refresh coolant in case of 

water loss or contamination.
 l A bottle of coolant (manufacturer: Koolance, part number: LIQ-702CL-B) is shipped with 

the analyzer. 
 l

If the specified coolant is unavailable, any 702 coolant may be used. For best results, 
blue or yellow is preferred. For more information, see Koolance 702 coolant.

 l Do not use water as coolant. Contact Koolance (https://koolance.com) for replacement 
bottles. Koolance has re-sellers in Asia, Australia, Europe, Canada, and the United States.

NOTE

NOTE

NOTE

https://koolance.com/liquid-coolant-bottles
https://koolance.com/liq-702-liquid-coolant-bottle-high-performance-700ml-blue
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 l The safety data sheet for LIQ-702CL-B is included in Chapter L, SDS for Koolance LIQ-
702.

4.7.1 Chiller Setup
1. Inspect the water buffer tank for possible cracks, and external water tube breakage. 

If damage is observed, stop, and contact Picarro support to get the damage repaired 
before adding coolant.

Opening the top black lid in the following steps is only for checking the coolant flow. 
For coolant refilling, open one of the ports to add additional coolant if needed.

Port for refilling coolant

Lid for checking coolant flow

Figure 16 - Reservoir Connections at Time of Shipment

2. Rotate the black top lid counter-clockwise to open the tank as shown in the following 
figure.

WARNING

NOTE

1

2
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Figure 17 - Reservoir Inspection

3. Fill the reservoir so that the coolant covers the sponge and reaches the last thread for the 
top lid.

Figure 18 - Reservoir Coolant Level

4. Make sure the two quick-connectors are fully plugged into the bottom of the reservoir.
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Quick-connectors

Figure 19 - Reservoir Connected and Ready to Run

5. Power on the analyzer per Startup procedure, see 5.1 Startup and check the coolant level 
while flowing. If the level drops below the level of the sponge in the reservoir, add coolant 
to full level directly from either one of two top venting ports.

6. To inspect the coolant flow, open the tank as shown and use a hex drive or a long pin to 
pinch the sponge, and reveal the two openings on the bottom of the reservoir. Make sure 
bubbles are forming.

Figure 20 - Confirmation of Coolant Flow

7. Replace the lid and tighten it clockwise.

1
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To turn off the analyzer, follow Shutdown, Section 5.2 Shutdown . Never remove the 
vacuum while the system is running. Doing so can damage the instrument which is 
not covered under warranty.

4.7.2 Chiller Maintenance
With the TEC chiller (thermoelectric cooler), a single buffer tank containing circulation 
coolant fluid is used to dissipate laser heat effectively. The general industrial heat transfer 
medium, Koolance LIQ-702, is used; see Chapter L, SDS for Koolance LIQ-702. 

The coolant should be maintained in proper level with refilling, or replacement if it is 
contaminated.

Coolant level should be checked monthly on its level which is due to evaporation or 
other loss. If the level is no more than half of full tank and the liquid is clear, adding 
coolant is needed.

Adding Coolant

Open the top two sealing ports, add only proper coolant to its maximal level of coolant buffer 
tank. This can be done when the analyzer is in operation.

Coolant clarity should be checked annually. The turbid coolant liquid indicates 
contamination. If the liquid is not transparent and the sponge in dark yellow, coolant 
replacement is needed. 

Coolant Replacement

Approximately 50 mL of fresh coolant is needed. Use the following procedure to replace the 
coolant within the chiller.

1. Turn off the analyzer.

2. Disconnect the two quick connectors from the bottom of the buffer tank.

3. Remove the tank from its holder, open the top lid, dump all coolant, wash the sponge.

4. Install tank back to its folder, put sponge back, seal top lid

WARNING

NOTE

NOTE
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5. Open the two top sealing ports, add coolant to full level.

6. Connect the two quick connectors fully back to position. Make sure there are no kinks 
along the tubes.

The reference coolant flow rate is typically as 0.25 lpm (liter per minute). A minimal flow 
rate of 0.15 lpm or above is required for laser cooling.

NOTE
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5 Analyzer Basic Operation
This section explains how to operate the analyzer using the GUI. It describes system startup, 
shutdown, and recovery procedures, desktop features. GUI Functions are detailed in section 
Chapter 6, GUI Functions.

Using this analyzer in a manner not specified by Picarro may result in damage to the 
analyzer and render it unsafe to operate.

During operation, do not position the analyzer so that it is difficult to operate the 
electrical disconnecting device (such as an emergency off (EMO) switch or breaker).

The illustrations shown in this chapter are for example only. What is shown on your 
instrument is dependent on the model analyzer in use and may differ.

5.1   Startup
1. Make sure the pump vacuum hose is connected between the analyzer and pump.

Always turn on the external pump before powering up the analyzer. This ensures a 
safe start-up sequence.

2. Verify the power cable to vacuum pump is plugged in.

3. Switch power on at the pump.

4. Verify the power cable to the analyzer is fully inserted into the power receptacle.

5. At the analyzer back panel, press the main power switch to the ON ( I ) position.

6. If needed, press the round Soft Power button on the rear panel. The LED indicator 
illuminates green. See   PI5131-i Front/Back Panels.

WARNING

CAUTION

NOTE

CAUTION
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The Picarro Launch Pad user interface displays and the CRDS Data Viewer (Figure 21) 
automatically starts within 30 seconds. For more information about the CRDS Data 
Viewer features, see Chapter 6, GUI Functions.

The analyzer will not begin producing data until the cavity temperature and pressure have 
reached their operational set points. A message will display in the Status Log window (Figure 
21, bottom panel) when each set point is reached. An explanation of the most common 
status log messages can be found in 6.11 Measurement Status Log.

Data is saved automatically whenever the analyzer produces data. The data displayed on the 
CRDS is the continuous real time read-out from the analyzer. A user-relevant subset of this 
data is stored in:

/home/picarro/I2000/Log/Archive/YYYY-MM-DD/DataLog_User

where Y = year, M = month, D = day. For more information see, Chapter 8, File Management.

In order to measure discrete samples (such as individual gas bags) or from multiple locations 
(when switching valves draw in ambient air from different heights) a separate software 
window (coordinator) is used to control the sample source and match the corresponding real 
time read out with the sample source. Depending on system configuration, coordinator 
programs may not be included.

Figure 21 - CRDS Data Viewer Screen

5.2   Shutdown 
This section describes how to safely shutdown the analyzer using dry gas, closing the CRDS 
application, and powering off the instrument from the Picarro Launch Pad.
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A flow of clean, dry gas should always be directed to the instrument for several minutes 
prior to shutting down. Trapping a high-moisture content gas sample in the cavity can 
cause condensation damage to the mirrors as the instrument cools from its operating 
temperature.

Do not turn off the pump or disconnect the vacuum line while the instrument is 
operating.

1. With the pump still running, switch to a source of clean, dry gas at the sample inlet and 
allow it to run until the water channel reading on the GUI falls below 2000 ppm. This will 
prevent any damage from condensation to the cavity surfaces. This dry gas may be from 
a tank (target 2-3 PSIG pressure) or from a desiccant column like the DrieRite column, 
C0360, sold on store.picarro.com).

2. From the CRDS Data Viewer select the Quit button located in the lower left corner of the 
window.

3. A message displays prompting the user to confirm the shutdown. Once confirmed, the 
CRDS Data Viewer turns off.

Note you must be logged in to shut down the analyzer.

Figure 22 - Stop Data Acquisition Confirmation

4. From the Picarro Launch Pad select Power Off to tun off the hardware.

5. Manually turn off the pumps and dry gas only if system requires it.

CAUTION

CAUTION

NOTE

https://store.picarro.com/
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Leave any dry gas or desiccant attached to the inlet during this process.

6. When the instrument fans audibly turn off, and when the green power button light on the 
front of the instrument turns off, shut off the pump manually from the rocker switch 
located on the pump.

5.3   Analyzer Restart after Electrical Power Outage
If power to the analyzer is cut-off for any reason the analyzer will cease operation. However, 
when the power is reapplied, the analyzer will restart automatically, the Picarro software 
tools will properly close out previous files and open new files for data collection so that 
previously collected data, instrument diagnostics and other parameters recorded up to the 
time of power outage are retained. 

If short power outages are common in the user location, Picarro recommends using an 
uninterrupted power supply (UPS) to protect the data stream and the health of the cavity. 

5.4   Picarro Launch Pad
The Picarro Launch Pad is the entry point for starting and using the analyzer. It provides 
access to the CRDS Data Viewer, tools, settings, and administrative controls for the 
instrument such as managing user accounts. This section provides an overview of the 
Picarro Launch Pad’s key features with additional information throughout this manual.

Picarro Launch Pad features vary depending on user account types. Each section 
describes the account type that is required for each of the main menu options.

5.4.1 Home Menu
Account Type: All Users

The Picarro Launch Pad automatically starts in Guest account mode and displays the home 
menu upon startup of the analyzer. Note several options are not accessible until you login 
with a user account. The Home menu options are provided, as shown in the following figure.

NOTE

NOTE
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Figure 23 - Picarro Launch Pad/Home Menu

 l Start Analyzer — Starts the analyzer and launches the CRDS Data Viewer.
 l DatViewer — When clicked, a window opens that allows you to convert between *.dat and 

H5 data files and to make various graphical representations of your data over time periods 
longer than what is available in the software buffer. The instructions on using the Data File 
Viewer software are described in Chapter F, Data File Viewer. Note requires login to the 
Picarro Launch Pad.

 l Log In — Provides access to the Picarro Launch pad and tools associated with a 
specified user account. 

Note options vary with different types of user accounts.

 l Log Out — Concludes the user account session.

NOTE
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 l Profile — Provides access to the User Management Tool to allow regular users to change 
their own password and administrators to manage user accounts.

 l Sage Autosampler — Starts the Sage Autosampler software application.

Requires a password to obtain entry. For more information, see 7.5 Viewing My 
Profile and 7 User Management.

5.4.2 Tools Menu
Account Type: Operators, Technicians, and Administrators

The Tools menu provides additional utilities for the instrument and include the following 
options as shown.

Figure 24 - Picarro Launch Pad/Tools Menu

 l CRDS Controller — Displays the Cavity Ring-Down Spectrometer Controller to view 
technical information about the analyzer operation.

 l Copy Files — Allows data to be copied to an external device. Requires technician or 
administrator permissions.

 l Support Export — Opens the CRDS Diagnostic Data Collector tool to curate support data 
for troubleshooting.

File Manager (Copy Files)

The File Manager is accessible from the Picarro Launch Pad from the Tools menu or directly 
from the CRDS Data Viewer Tools menu using the Files button. Follow the procedure to copy 
data to an external drive.

NOTE
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1. On the home page, click on Files.

2. From the Picarro Launch Pad, click on the Tools menu and Copy Files button.

3. Login using user credentials.

4. Plug in an external USB drive.

5. In the bottom right-hand corner, select mount and choose the desired drive. After 
selecting, files will be populated on the right side with from the USB drive

6. Using the upper left-hand corner drop down menu, select the type of file: Data, 
Screenshot, User History, Validation Report.

7. Highlight and select the desired files.

8. Click Copy to copy or move to transfer file to USB drive.

9. Unmount the USB drive when file transfer/copy is complete.

Figure 25 - Transfer Files Dialog

5.4.3 Settings Menu (Setup Tools)
Account Type: Technicians and Administrators

The Settings menu provides various configuration options for the analyzer and is described 
in detail in Chapter A, Setup Tools and Communication.

5.4.4 Administration Menu
Account Type: Administrators

The Administration menu provides the following options.
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Figure 26 - Picarro Launch Pad/Administration Menu

 l Windowed Mode — Displays the Picarro Launch Pad and utilities as windows within the 
user interface.

 l Network — Provides configuration of network settings.
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 l Clock — Sets the time of the hardware clock.

The clock, date, and network settings are not accessible if the instrument is running. 
Use one of the following procedures to access these settings.

Option 1:
You can access the clock and other system settings when starting the analyzer and 
logging in within 30 seconds of the Picarro Launch Pad Home screen appearing. This 
will pause the automatic launch of the drive. After configuring the settings, return to 
the Home screen to start the analyzer.

Option 2:
If the instrument is running, users can access the clock and other system settings by 
selecting Shift (keyboard) + Quit button from the CRDS Data Viewer Screen. This 
action will stop the software and driver, allowing access to the settings. Note: 
Disabling the driver is necessary only to access the clock settings. Using the Quit 
button alone is sufficient to access other system settings, and it is recommended to 
keep the driver running whenever possible.

 l User Accounts — Provides access to the User Management Tool for managing user 
accounts, security settings and user history. Requires a password to obtain entry. For 
more information, see Chapter 7, User Management.

 l System Backup — A mechanism for backing up or restoring system settings.
 l Toggle Modbus — Allows enabling and disabling of the Modbus interface for 

configuration of the communication protocol.
 l Launch Shell — Opens a command line interface.

5.4.5 Language Selector
The Language selector allows you to change the language of the user interface. This includes 
the Picarro Launch Pad and CRDS data Viewer. Use the following procedure to set the 
desired language.

1. From the Picarro Launch Pad select English or Chinese .

NOTE
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Language selector

Figure 27 - Language Selector

2. Click OK to confirm the language change.

Figure 28 - Language Change Confirmation

The selected language displays immediately for any new applications that are 
started. Restart any currently running applications for the change to take effect.

1

NOTE
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6 GUI Functions
This chapter describes the GUI features of the CRDS Data Viewer. 

The illustrations shown in this chapter are for example only. What is shown on your 
instrument is dependent on the model analyzer in use and may differ.

6.1   GUI Overview
The features of the GUI as shown below are described in the following sections.

Users, View, Tools, 
and Help menus

Digital Readouts and 
Statistics

Data Source, Data 
Key, and Precision 
menus for data 
window content

Axis Auto Scaling

Reset Data Buffer

Instrument Status

Quit Button

Alarm Panel

Restart User Logs 
button

Data Log; Filename, 
and Path

Status Log Window

Data Windows

 

NOTE

1

2

3

4

5

6

7

8

9

10

11

12
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Figure 29 - CRDS Data Viewer GUI

6.2   Users, View, Tools, and Help Menus

Figure 30 - CRDS Toolbar Options

6.2.1 User Menu
 l User Login — Provides access to the CRDS Data Viewer. If you do not have an account 

one can be created by an administrator.
 l User Logout — Disables access to the CRDS Data Viewer functions. 
 l Bottom Panel — Displays or hides the Instrument Status, Alarms, Data File, and 

Measurement Status panels at the bottom of the CRDS Data Viewer.
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Select to show or hide the Instrument Status, Alarms, Data File, and Measurement 
Status panels

Figure 31 - Show/Hide Bottom Panel

6.2.2 View Menu
The View menu provides the following options that can be enabled. Note that when toggled 
on, a check mark displays to indicate the enabled feature.
 l Lock/Unlock time access when zoomed — When locked, forces the data windows to 

display the same time scale during zoom.
 l Statistics — Toggles the measurement statistics display, see the 6.4 Digital Readouts.
 l Instrument Status — Toggles the instruments status display. See the 6.5 Instrument 

Status.

1
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 l Graph — Set the desired number of line graphs to be visible on the CRDS Data Viewer. 

Figure 32 - Configure Graph Window

The data buffer resets when the number of graphs are changed.

6.2.3 Tools Menu
Use the Tools drop-down menu to plot data, copy data, perform user admin tasks, calibrate 
the instrument, or show/hide the valve sequencer GUI. The Tools menu features are as 
follows:
 l User Calibration — Opens the password protected user calibration window (default 

password is picarro). For more information, see Appendix I, Analyzer Calibration (Initial).
 l User Administration — Provides access to User Management options for managing user 

accounts, policies, viewing histories and profiles.
 l DatViewer — Allows plotting of data saved in *.dat and *.h5 files.
 l Files — Copies data to an external drive using the File Manager.
 l Analyzer User Manual — Opens the user manual in PDF format.
 l Show Valve Sequencer GUI — Toggle to display the external valve sequencer window 

(use alt-tab to bring it to the front).

6.2.4 Help Menu
 l About — Displays the software release version of the instrument.

6.3   Alarms Panel
This panel is used to monitor the status of the internal instrument alarms. These indicators 
are gas concentration alarms, such as “N2O Too High/Low” depending on instrument 
configuration. The gas concentration alarm icons are off (grayed) when the respective 
concentrations are below a certain value, and they are illuminated red when the respective 
concentrations are above/below a certain value. 

NOTE
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High/low alarm settings are not intended as a safety measure as configured at the 
factory, either with respect to human health or the health of the analyzer. It is up to the 
customer to determine the meaning and level of a “high” or “low” value based on their 
application.

Figure 33 - Alarm Panel

Alarm Panel Indicators are colored as follows:

System Alarm:
 l Green when the analyzer is measuring properly
 l Flashing yellow when the analyzer is warming up
 l Yellow when not warming up properly
 l Red when not operating properly

Measurement Range Alarm:
 l Green when concentration is within analyzer measurement range
 l Red when above analyzer measurement range

Custom Range Alarm:
 l Green when within boundaries set by the user
 l Red when not within boundaries set by the user
 l Grey when alarm is disabled by the user (these are disabled by default)

To view the alarm set point, click on the Alarm Icon and a dialog box displays indicating the 
alarm setting and allows the user to enable it or change the setpoint.

CAUTION
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Figure 34 - Alarm Set Dialog

This feature allows reading or changing the alarm settings and the ability to enable it or 
change the set point. The indicator illuminates when the concentration goes above the set 
point and resets (indicator off) below the set point. The alarm modes for gases are:
 l Higher
 l Lower
 l Inside
 l Outside

Type the value you wish to set the alarm to and click the OK button or Cancel if you do not 
wish to change the alarm value. If you do nothing, the dialog box will disappear, and the 
alarm value will remain unchanged. The units are those that appear in the GUI graph. 

6.4   Digital Readouts
Displays the latest value recorded for the selected Data Key for each Data Window. 
Changing the Data Key changes the Digital Readout as well as the Data Window view.

If the Statistics entry is enabled in the View menu, the mean, standard deviation, and slope of 
the data in the graph is dynamically calculated and indicated below the digital concentration 
readout. These numbers change to reflect statistics of whatever data is in the data window. 
Zooming into a section of existing data will show the statistics statically for that time period, 
while the digital readout above the statistics continues to update with the latest value. See 
6.13 Graph Zooming and Panning for more information.
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With Show Statistics Enabled With Show Statistics Disabled

Figure 35 - Digital Readouts Panel

6.5   Instrument Status
If these parameters are enabled through the Instrument Status entry in the View menu on the 
main toolbar, digital readouts for Warm Box temperature, Cavity Temperature, Cavity 
Pressure, and Box Pressure are displayed below the digital readouts panel.

Figure 36 - Instrument Status Panel

6.6   Quit Button
Shuts down the analyzer. See 5.2 Shutdown .

Figure 37 - CRDS Quit Button

1 2
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6.7   Restart User Log(s) Button
The analyzer automatically records all data collected on the instrument as .dat files. These 
are described further in section 8, File Management.

To start a new data file (time-coded to the current second), click the Restart User Log(s) 
button. The new file name should be visible beneath the button in a few seconds.

Figure 38 - Restart User Logs Button

6.7.1 Data Log Filename and Path
The filename and path of the active data log is displayed in this pane. The indicator is grayed-
out when there is no active data log before gas measurement reporting begins. A new file is 
generated when the instrument starts reading gas concentrations, (e.g., “153719”) and 
subsequently at 1 hour increments (e.g., “163719”, “173719”). A new day folder (e.g., “2025-
07-30”) will be generated at midnight, as will month and year folders at the appropriate times.

Figure 39 - Data Log Filename and Path Panel

6.8   Data Window
The data window displays a graph of any stream of data vs. system time, with a format of 
hh:mm:ss. The user can select which data streams are displayed using combinations from 
the Data Source and Data Key pull down menus. The precision displayed can be adjusted 
using the Precision menu. Auto-Scaling of the Y-axis is also available. Clicking any 
Autoscale button scales its Y-axis if the plot hasn’t done this automatically.
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Source Keys

Data Keys

Precision

Auto Scale

Reset Buffers

Plot for Data Key 

Figure 40 - Data Window Panel 

6.9   Data Source and Data Key Pull Down Menus
Data Source and Data Key menus enables selection of the data stream that is viewed in the 
data window. 
 l Gas concentrations — If instrument Analysis (where instrument represents the system 

installed) is selected.
 l Sensor Readings — If Sensor is selected, the analyzer’s sensor and controller readings, 

as well as the some status flags of the analyzer can be viewed.
 l  

Figure 41 - Data Source and Data Key Pull Down Menus

6.10   Precision Pulldown Menu
Click on the pull-down to select the precision displayed on the y-axis; between 0 and 4 digits 
of precision or auto. The currently selected precision is displayed during operation. This 
does not affect the precision of the saved data in the data log files or results files. Auto 
precision is sufficient for nearly all applications.

1

2

3

4

5

6

pi5131-crds-data-window.png
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Figure 42 - Precision Pull-down Pane

6.11   Measurement Status Log
This window displays instrument status messages, in the following form: 
YYYY-MM-DD HH:mm:ss, then Generic message text.

6.11.1 Common Status Log Messages
Following are the most common messages that appear:
 l Pressure Stabilizing/Locked — Displayed when the valve control system begins to allow 

flow through the analyzer and stabilizes the pressure inside the cavity.
 l Temperature Locked — WB: When the temperatures of the warmbox have stabilized. 

This is typically the longest step in the startup sequence. Startup: Depending on ambient 
temperature, the analyzer and its hotbox temperature set point, this step may take as little 
as 20, or as much as 60 minutes. Restart: If the instrument is only stopped briefly, this 
may take a few seconds to a few minutes.

 l Preparing to Measure — Spectral scanning has started. Concentration measurements 
will be available in approximately 30 seconds. The instrument will continue to scan and 
report concentration measurements until the instrument is shut down.

 l Measuring — This is the normal mode of operation after startup has completed.

Figure 43 - Measurement Status Log

6.12   Reset Buffers Button
Click the Reset Buffers button to clear the internal data buffer of the GUI (this clears the 
current data traces from the graphs). This has the effect of clearing all data in the data 
window. Pressing this button has no effect on any of the data log files stored by the 
instrument.
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6.13   Graph Zooming and Panning

6.13.1 Zooming In/Out
To zoom in on a specific region of the graph, move the cursor to the area of interest, 
click/hold the left mouse button, then drag as desired to create a box that covers the region 
of interest. When the box is drawn, release the left button and the boxed area will 
automatically scale to fill the data window. 

Figure 44 - Data Graph Zoom Function

To zoom out to see all data in the buffer, double-click the left button within the graph display. 
To zoom out indefinitely, right click. Right clicking multiple times zooms out further. To auto 
scale the y-axis of either graph, use the Auto-Scale buttons as shown in the following figure.

To Zoom the X and Y axes: hold down the control button and move the cursor up/down or 
left/right using the right mouse button

Figure 45 - Auto-scale Buttons

6.13.2 Lock/Unlock Time Axis
Zoom and pan features are often useful when time axes are locked, and the user wishes to 
align the Y axis in multiple plots. To lock or unlock the time axis of each graph during 
zooming, from the View menu, select Lock time axis when zoomed or Unlock time axis.

6.13.3 Panning
To pan the data in the X or Y axis: hold down the control button and drag the cursor using 
the left mouse button.



7 User Management

70 PN 40-0141, REV A PI5131-i User Manual

7 User Management

7.1   Overview
User management includes:
 l Managing user accounts, such as adding users and changing passwords.
 l Setting user policies, such as password requirements and session duration.
 l Viewing and saving user histories.

There are three user roles defined in the system: operator, technician, and administrator. The 
permissions are as follows:

Table 4 - User Accounts and Functions

Function
Not 

Signed 
In

Operator Technician Administrator
System 

Manager*

View Data Viewer • • • • •

Set Alarms  • • • •
Configure Data Viewer 
(partial) 

 • • • •

Quit Measuring  • • • •

Quit (software shutdown)  • • • •
Configure Data Viewer 
(full access)

   • • •

User Management    • • •
Software Management
(installation/uninstallatio
n)

       •

*Contact Picarro support at support@picarro.com to obtain System Manager user access.

User management settings are available from the Tools menu in the Data Viewer or by using 
the Picarro Launch Pad. Use one of the following procedures.

mailto:support@picarro.com
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From the Data Viewer:

1. From the Users menu, select User Login.

2. Login as an administrator (default user name is admin; default password is admin).

3. From the Tools menu, select User Administration to view the User Management a shown 
in Figure 46.

From Picarro Launch Pad:

1. Login to the Picarro Launch Pad as an administrator (default user name is admin; default 
password is admin).

2. Select Administration and User Accounts.

3. From the User Management Tool login as an administrator (default user name is admin; 
default password is admin).

4. The User Management window displays and has four tabbed states: User Accounts, 
User Policies, User History and My Profile.

Figure 46 - User Management Window

7.2   Managing User Accounts
The following features are available from the User Accounts tab and are further described in 
this section:
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 l Add new users
 l Disable users
 l Change user passwords
 l Change user roles

The default user names that are provided with the analyzer are tech, operator, and 
admin. The default passwords are tech, operator, and admin, respectively. User names 
and passwords are both case sensitive.

7.2.1 Changing a User Password
1. In the User Management window, click the User Accounts tab.

2. From the list of users, click the user you want to change and select the Edit User button. 
The user account information displays.

Figure 47 - Change Password

3. In the Password field, enter the new password.

Passwords are case sensitive. Additional rules for passwords can be set in the User 
Policies tab. For more information, see 7.3 Setting User Policies

4. In the Password Confirmation field, re-enter the password.

5. Click Save to save the password.

NOTE

NOTE
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To change your own password for your account, see 7.5 Viewing My Profile.

7.2.2 Changing a User’s Role
1. In the User Management window, click the User Accounts tab.

2. From the list of users, select the user you want to change and click the Edit User button.

3. From the Role field, select the new role and click Save.

The role is now changed to the desired setting.

Figure 48 - Change Roles

7.2.3 Disabling a User Account
Users cannot be deleted from the system, but they can be disabled to prevent access to the 
software. Use the following procedure to disable a user.

1. In the User Management window, click the User Accounts tab.

2. From the list of users, select a user name. 

3. Click Disable User; this will prompt you to confirm your choice.

4. Click OK to confirm the action.

NOTE
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Figure 49 - Disable Users

7.2.4 Adding a User
1. In the User Management window, click the User Accounts tab.

2. Click Add User; this will display the Add User screen.

Figure 50 - Add User
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3. Fill in the fields in the Add User window.

4. Click Save to open the New User Account dialog.

5. Review the user information and click OK to accept or Cancel to go back and edit the 
information.

7.3   Setting User Policies
1. In the User Management window, click the User Policies tab.

2. Make any changes. For more information, see the following 7.3.1 User Policy 
Descriptions.

3. Click Save. If you typed an incorrect value and want to undo any changes and revert 
back to the last saved configuration, click Revert.

Figure 51 - User Policies Tab

7.3.1 User Policy Descriptions
The following table provides descriptions for the various user policies.
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Table 5 - User Policies

Policy Description

Password 
length

Specify that the length of passwords (6–15 characters) or turn off the length 
requirement.

Password 
complexity

When selected, all new passwords must have at least one number, one 
letter, and one special character. This will not impact existing passwords.

Password 
expiration

When selected, any passwords that reach the selected maturity will expire. 
Any user signing in with an expired password will be required to create a 
new password.

Previous 
passwords 

When set, prevents a user from reusing a recent password. The system can 
remember up to 10 old passwords.

Limit login 
attempts

Tell the system to disable a user account after a set number of failed 
password attempts. The failed attempts are counted until the user 
successfully logs in. Once disabled, an admin will have to enable the 
account.

Lock 
session

When set, the system will automatically logoff any user after a set period of 
inactivity, requiring the user to sign in again.

Change 
password

Allows the user to change their own password.

Change 
phone 
number

Allows the user to change phone number and restrictions.

Change 
email

Allows user to change their email address.

Change 
name

Allows the user to change first and last name.

Save user 
actions

When enabled, user actions (such as logging in) will be saved in the User 
History.

7.4   Viewing User History
1. In the User Management window, click the User History tab to see a list of all the logged 

events.
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Figure 52 - User History Tab

2. Click the < and > buttons to navigate through the history (if the button is grayed out, then 
there are no additional pages).

3. To make sure the content is up to date, click Refresh.

4. To copy the user history onto a USB drive, click Download. This launches the File 
Manager, which will prompt to login. See  File Manager (Copy Files) for details on copying 
files from the analyzer.

7.5   Viewing My Profile
The My Profile tab provides information about the user that is currently logged into the 
system. The change password, phone number, email and name options are available to 
the user if these settings were enabled in the User Policies tab by an administrator. The 
user can use these options to edit their own profile information.
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Figure 53 - My Profile Tab
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8 File Management
The Picarro Analyzer generates ASCII-format text output files that are updated after each 
batch of concentration measurements is complete. The data files are stored primarily in 
DataLogger folders and are also mirrored in folders which retain more situational data. Some 
analyzers also produce discrete measurements stored in separate isotope data folders. All 
user data is archived, compressed, and retained, either shortly after the measurements or at 
a later point, to optimize space on the hard drive.

8.1   Data Archive 
The archive directory is:

/home/picarro/I2000/Log/Archive

This archive stores daily measurement and RDF data. Each folder is designated by date 
(YYYY-MM-DD) and has subdirectories:

DataLog_Private, DataLog_User, DataLog_ EventLogs, and WBCAL.

The Data Logger files are in a simple text format (white-space delimited) with a DAT file 
extension. By default, each file stores one hour of data.

Certain instruments may contain additional sub-folders under: /Home/UserData relating to 
time synced file formats, soil flux, or GPS data, among others. If the user has any questions 
about this file structure, they can contact Picarro Support.

There are complete data files which include additional information beyond the concentration 
data including parameters such as instrument temperatures and pressure, set points and 
spectroscopic information. This information is generally not useful to the user, but can be 
useful for diagnostic purposes and is stored in the following directory:

/home/picarro/I2000/Log/Archive/yyyy-mm-dd/DataLog_Private

The archive files are in a HDF5 format, a more efficient data storing format with an .h5 file 
extension.

If you install the Picarro Sage autosampler, the system stores the related data in the 
following directory: home/picarro/Picarro Sage

8.2   Data File Name
The file name is generated from the analyzer serial number, the date, and the time when the 
file was started. The specific time stamp depends upon the time the instrument was started 
and began measuring sample gas, so files seldom begin exactly at the top of the hour. For 

NOTE
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example:

Instrument Serial Number

Date

Time (Local)

Figure 54 - Example Data File Name

 l JEDS5800: the analyzer serial number
 l 20250729: the date, in format yyyymmdd (to allow chronological sorting of data files).
 l 201511: the time the file was started in the computer’s local time 20:15:11, formatted as 

hhmmss using a 24-hour clock. Note that the time stamp of samples within the file is 
usually recorded in UTC (GMT) relative to the local time. For example, an analyzer in 
California will usually have a time stamp (UTC) within the file that is 8 hours ahead of the 
time stamp in the file name itself (UTC - 8). 

8.3   File Archiving
Picarro instruments will not delete data. Some instruments will, however, compress and 
archive older data to conserve hard drive space. Raw data file archiving frequency and 
details can be modified in the file: 

/home/picarro/I2000/AppConfig/Config/Archiver/Archiver.ini.

To avoid losing data, discuss with Picarro support before attempting any changes to the 
Archiver.ini file.

For each file type, there are various items along with some recommended default settings 
which may vary by file type:
 l Directory = /home/picarro/I2000/Log/Archive

Optionally specifies which directory to find files to archive.
 l MaxCount = -1

Specifies how many files to keep. A setting of -1 indicates that there is no maximum 
number of files. Generally, -1 is used in conjunction with a maximum size limit, below.

1

2

3

CAUTION
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 l MaxSize_MB = 1500
Specifies that a maximum of 1.5 GB of data is to be kept before the system begins to 
archive old data.

 l Compress = True/False
Specifies if archived files are to be zipped – recommended setting is true to save hard 
drive space. True means files are zipped, false means files are not zipped.

 l AggregationCount = 0
If compression is set to TRUE, specifies how many files to be included in each zip archive.

 l StorageMode = FIFO
First in first out. Specifies that old data is archived first.

 l Quantum = 4
Generally, should not be changed. Specifies the files to be sorted by year\month\day\hour 
in the archived directory structure.
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9 Modbus Communication
Modbus is a client/server data communication protocol to support communication to and 
from multiple devices connected to the same cable. Modbus can be configured for TCP/IP 
on port 50500 or RTU utilizing the analyzer’s COM1 port. See the following section on how to 
configure Modbus communication. 

9.1   Configuring Modbus Communication
1. From the Picarro Launch Pad, select Config followed by the Modbus button to configure 

the Modbus server as shown in the following figure.

Note the Config menu requires login to access the configuration menu. Log in with a 
user name and password.

Modbus button

Figure 55 - Settings/Modbus Configuration

This displays the Modbus Settings window shown in Figure 56. 

NOTE

1
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Figure 56 - Modbus Settings Window

2. From the Modbus Settings window the following configuration options are available:
 l Slave ID — The analyzer’s Slave ID.
 l Modbus Type — The Modbus Communication Protocol: TCP/IP or RTU. For more 

information, see section 9.2   Modbus Data Registers Overview and Setup.
 l TCP Port — Designates the TCP port if TCP/IP is selected.

Additionally, the window displays the CommandInterface Status. However, if Modbus 
Type is set to RTU, then the CommandInterface on COM 1 is disabled.

9.2   Modbus Data Registers Overview and Setup
This section describes the basic types of MODBUS data registers and setup information. 

Table 6 - MODBUS Register Types

Name Size Access

Input Register 16 bits Read-only

Holding Register 16 bits Read-write

Discrete Input 1 bit Read-only

Coils 1 bit Read-write
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9.2.1 Modbus TCP Setup Notes
 l MODBUS is configured for TCP/IP on port 50500.
 l When MODBUS is configured on port 50500, communication is also possible via port 502.
 l If MODBUS is configured as TCP/IP and the IP address of analyzer is changed, the user 

needs to restart the host application to run MODBUS with the updated IP address. 
 l MODBUS over TCP/IP does not support privileged ports (0 to 1023), except for port 502.

9.2.2 Modbus RTU Setup Notes
 l MODBUS RTU uses the analyzer’s COM1 port.
 l To establish connection between master and slave over MODBUS RTU, user needs to 

establish connection using "Straight Through Cable”. 
 l When MODBUS is configured for RTU, CommandInterface on COM1 is disabled. 

9.3   Modbus Register Maps
 l Data returned is in big endian format if it utilizes more than one Modbus register. 
 l If input register functionality is not available for a given analyzer type, the instrument will 

return value as “NaN” for float values and “False” for 1-bit registers.
 l Memory map is continuous memory. If a user tries to read a register address for which 

functionality is not available, it will return “0”. For example, reading address “0” for coil 
registers returns “0” since the address does not exist.

 l If a user tries to read a register address outside of maximum register memory map, the 
request will return an exception. For example, reading address 156 for coil register will 
return exception code “0x02” (Illegal address). 

 l System time is in milliseconds since 0001-01-01 AD.

9.4   Input Register Map
Most of the readings in the Picarro analyzer are the float type and need 32-bit data. Each 
parameter utilizes two registers, out of which the first one stores the MSB and the second 
stores the LSB of the float number.

Table 7 - Input Registers

Address Description Units Type Comments

1-6 Time stamp String Float
Long value return as 12 byte string. 
Date will be in format 
YYMMDDHHMMSS

7-8
N2O 
Concentration

ppb Float  
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Address Description Units Type Comments

9-10 N2O_ID Unitless Integer 8 for N2O

11-12 N2O_30sec ppb Float  

13-14 N2O_2min ppb Float  

15-16 N2O_5min ppb Float  

17-18 N2O_Maximum ppb Float  

19-20 N2O_Minimum ppb Float  

21-22 d15Nalpha per_mil Float  

23-24 d15Nalpha_ID Unitless Integer 81

25-26
d15Nalpha_
30sec

per_mil Float  

27-28 d15Nalpha_2min per_mil Float  

29-30 d15Nalpha_5min per_mil Float  

31-32
d15Nalpha_
Maxinum

per_mil Float  

33-34
d15Nalpha_
Minimum

per_mil Float  

35-36 d15Nbeta per_mil Float  

37-38 d15Nbeta_ID Unitless Integer 82

39-40
d15Nbeta_
30sec

per_mil Float  

41-42 d15Nbeta_2min per_mil Float  

43-44 d15Nbeta_5min per_mil Float  

45-46
d15Nbeta_
Maxinum

per_mil Float  

47-48
d15Nbeta_
Minimum

per_mil Float  

49-50 d18O per_mil Float  
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Address Description Units Type Comments

51-52 d18O_ID Unitless Integer 83

53-54 d18O_30sec per_mil Float  

55-56 d18O_2min per_mil Float  

57-58 d18O_5min per_mil Float  

59-60 d18O_Maxinum per_mil Float  

61-62 d18O_Minimum per_mil Float  

63-64 co2 per_mil Float  

65-66 co2_ID Unitless Integer 2

67-68 co2_30sec per_mil Float  

69-70 co2_2min per_mil Float  

71-72 co2_5min per_mil Float  

73-74 co2_Maxinum per_mil Float  

75-76 co2_Minimum per_mil Float  

77-200 Reserved

201-202 CavityPressure Torr Float  

203-204 CavityTemp oC Float  

205-206 DasTemp oC Float  

207-208 EtalonTemp oC Float  

209-210 WlmTemp oC Float  

211-212 OutletValve Unitless Integer  

213-214
Gas1_instrCal_
slope

Unitless Float NaN

215-216
Gas1_instrCal_
offset

Unitless Float NaN
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Address Description Units Type Comments

217-218
Gas1_userCal_
slope

Unitless Float NaN

219-220
Gas1_userCal_
offset

Unitless Float NaN

221-222
Gas2_instrCal_
slope

Unitless Float NaN

223-224
Gas2_instrCal_
offset

Unitless Float NaN

225-226
Gas2_userCal_
slope

Unitless Float NaN

227-228
Gas2_userCal_
offset

Unitless Float NaN

229-230
Gas3_instrCal_
slope

Unitless Float NaN

231-232
Gas3_instrCal_
offset

Unitless Float NaN

233-234
Gas3_userCal_
slope

Unitless Float NaN

235-236
Gas3_userCal_
offset

Unitless Float NaN

237-238
Gas4_instrCal_
slope

Unitless Float NaN

239-240
Gas4_instrCal_
offset

Unitless Float NaN

241-242
Gas4_userCal_
slope

Unitless Float NaN

243-244
Gas4_userCal_
offset

Unitless Float NaN

301-302 Etalon1 Unitless Float  

303-304 Etalon2 Unitless Float  
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Address Description Units Type Comments

305-306 Ratio1 Unitless Float  

307-308 Ratio2 Unitless Float  

309-310 Reference1 Unitless Float  

311-312 Reference2 Unitless Float  

313-386 Reserved

387-388 Errors Unitless Integer  

389-390
Measurement_
Status

Unitless Integer  

9.5   Discrete Input Register Map
 l All data unit are unitless unless otherwise noted. 
 l All data types are floats unless otherwise noted.
 l All unused addresses are reserved.

Table 8 - Discrete Input Registers

Address Description

1 MasterSystemStatus

6 CavityPressureStatus

7 CavityTempStatus

8 WarmBoxTempStatus

9-72 Reserved

73 Incomplete_GAS1_spectrum

74 Incomplete_GAS2_spectrum

75 Incomplete_GAS3_spectrum

76 Incomplete_GAS4_spectrum

77 Incomplete_GAS5_spectrum

78 Incomplete_GAS6_spectrum
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Address Description

79 Incomplete_GAS7_spectrum

80 Incomplete_GAS8_spectrum

81 GAS1_baseline

82 GAS2_baseline

83 GAS3_baseline

84 GAS4_baseline

85 GAS5_baseline

86 GAS6_baseline

87 GAS7_baseline

88 GAS8_baseline

89 GAS1_performance

90 GAS2_performance

91 GAS3_performance

92 GAS4_performance

93 GAS5_performance

94 GAS6_performance

95 GAS7_performance

96 Reserved

9.6   Holding Register Map
The following table describes the holding registers.

Table 9 - Holding Registers

Address Description Type Comments

1-4 SyncTime Integer
Integer representing milliseconds from 1AD 
January 1st to now 
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Address Description Type Comments

5-8 UserName String  

9-12 Password String  

13-200 Reserved

201-202 User data 1 Float  

203-204 User data 2 Float  

205-206 User data 3 Float  

207-208 User data 4 Float  

209-210 User data 5 Float  

211-212 User data 6 Float  

213-214 User data 7 Float  

215-216 User data 8 Float  

217-218 User data 9 Float  

219-220 User data 10 Float  

221-222 User data 11 Float  

223-224 User data 12 Float  

225-226 User data 13 Float  

227-228 User data 14 Float  

229-230 User data 15 Float  

231-232 User data 16 Float  

233-234 User data 17 Float  

235-236 User data 18 Float  

237-238 User data 19 Float  

239-240 User data 20 Float  

9.7   Coil Register Map 
The following table describes the coil registers.
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Table 10 - Coil Register Map

Address Description Type Functions

1 EnergizeSolenoidValve1 Float get_system_time

2-115 Reserved

116 ShutDownHost Float MODBUS_ParkInstrument

117 ShutDownInstrument Float MODBUS_ShutdownInstrument

118-150 Reserved

151 GetTime Float get_system_time

152-154 Reserved

155 SetPassword Float Change_UserPassword

156 Logout Float MODBUS_UserLogoff

157-200 Reserved

201 GetUserData_1 Float GetUserData_1

202 SetUserData_1 Float SetUserData_1

203 GetUserData_2 Float GetUserData_2

204 SetUserData_2 Float SetUserData_2

205 GetUserData_3 Float GetUserData_3

206 SetUserData_3 Float SetUserData_3

207 GetUserData_4 Float GetUserData_4

208 SetUserData_4 Float SetUserData_4

209 GetUserData_5 Float GetUserData_5

210 SetUserData_5 Float SetUserData_5

211 GetUserData_6 Float GetUserData_6

212 SetUserData_6 Float SetUserData_6

213 GetUserData_7 Float GetUserData_7

214 SetUserData_7 Float SetUserData_7
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Address Description Type Functions

215 GetUserData_8 Float GetUserData_8

216 SetUserData_8 Float SetUserData_8

217 GetUserData_9 Float GetUserData_9

218 SetUserData_9 Float SetUserData_9

219 GetUserData_10 Float GetUserData_10

220 SetUserData_10 Float SetUserData_10

221 GetUserData_11 Float GetUserData_11

222 SetUserData_11 Float SetUserData_11

223 GetUserData_12 Float GetUserData_12

224 SetUserData_12 Float SetUserData_12

225 GetUserData_13 Float GetUserData_13

226 SetUserData_13 Float SetUserData_13

227 GetUserData_14 Float GetUserData_14

228 SetUserData_14 Float SetUserData_14

229 GetUserData_15 Float GetUserData_15

230 SetUserData_15 Float SetUserData_15

231 GetUserData_16 Float GetUserData_16

232 SetUserData_16 Float SetUserData_16

233 GetUserData_17 Float GetUserData_17

234 SetUserData_17 Float SetUserData_17

235 GetUserData_18 Float GetUserData_18

236 SetUserData_18 Float SetUserData_18

237 GetUserData_19 Float GetUserData_19

238 SetUserData_19 Float SetUserData_19
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Address Description Type Functions

239 GetUserData_20 Float GetUserData_20

240 SetUserData_20 Float SetUserData_20
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10 Troubleshooting
The following section lists problems that may be encountered during installation and 
operation of the analyzer. The corresponding step-by-step procedures provide resolution in 
most cases. If, after attempting these procedures, the problem remains unresolved, please 
contact Picarro Customer Support at +1 408 962 3991 (US) or +31 85 888 1650 
(International) or support@picarro.com.

10.1   Power LED on Analyzer Does Not Illuminate
Context: Turning on the analyzer by momentarily depressing its front panel power switch 
should apply power. The green power LED is illuminated when it detects the correct power 
levels.

1. Check that the AC power cord is attached and plugged into a working outlet.

2. Check that the rear on-off switch near the AC power cord is in the ON position ( I ).

3. Press and hold the front panel power switch for at least 5 seconds as the analyzer may 
take several seconds to respond.

10.2   Sample Pressure not Controlled to Appropriate Value for 
Concentration Measurements
Context: Under normal operation, the cavity pressure is automatically locked to the correct 
value by means of electronically controlled inlet and outlet valves. The message “Pressure 
Locked” on the front panel display and the user interface indicates that the cavity pressure is 
at the appropriate value. Should either of the messages “Pressure high” or “Pressure low” be 
displayed, the cavity pressure is out of its correct operating range. 

 1. Pressure low — Indicates that there is insufficient gas available at the inlet of the analyzer. 
Check the inlet plumbing to the analyzer and ensure that the pressure at the inlet is within 
the specifications. Check for blockages in the lines, or regulators that are turned off, 
especially by removing all items upstream of the inlet to see if the pressure returns to the 
spec. If removing plumbing from upstream of the instrument inlet doesn’t work, the inlet 
particulate filter may need to be replaced. See  for more information.

 2. Pressure high — Indicates that gas cannot be removed from the analyzer at a sufficient 
rate. Check the vacuum line between the analyzer and the power vacuum unit for leaks. 
Failure of the vacuum pump, injecting dilution gas at excessive pressure, or excessive 
pressure at the inlet can also cause this problem

mailto:support@picarro.com
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11 Maintenance
The advanced, rugged design of Picarro Analyzers provides stable, long-term operation with 
minimal service or maintenance. Except for the following items, the analyzer and pump are 
not user serviceable. Should either appear to malfunction, please refer to the 
Troubleshooting Guide or contact Picarro Customer Support (support@picarro.com). 

As described below, users may obtain preventive maintenance components as part of a 
service plan, as part of a designated PM kit, or individually from the Picarro store. 

11.1   Service Plans
In addition to basic telephone and email support and remote diagnostics, service plans 
include additional warranty, factory repairs, and parts. Plans are available for purchase by 
contacting sales@picarro.com. The following service plans are available for the PIxxxx and 
Gxxxx series analyzers:
 l W3105 Premium Service Plan — Extended warranty; free factory repair; free field 

replaceable parts. See data sheet for complete terms and conditions.

11.2   Particulate Filter Replacement
There are two user-replaceable filters in the PI5131-i analyzer. One is located behind the 
Sample inlet, and another is located behind the Pressure inlet. Both are accessible from the 
back panel by releasing the captive screws and sliding the filter out of its bay within the 
analyzer. This section describes filter replacement for the Sample and Pressure inlets. 
Replacement filter kits can be purchased from Picarro.

Gas at the Sample inlet is filtered by two in-line, sub-micron particulate filters before 
they reach the measurement cavity. The inner filter is not user replaceable. It is located 
within a heated pressure-box. If the inner filter fails, contact Picarro for service or repair. 
The outer filter (located just behind the Sample inlet) is user-replaceable.

The inner filter (in the sample path) is not user replaceable. Do not open the analyzer. 
Inner filters must be replaced by a Picarro certified technician. USER REPLACEMENT 
OF THE INNER FILTER OR BREAKING THE ANTI-TAMPER TAPE ON THE INNER 
FILTER VOIDS THE WARRANTY.

NOTE

CAUTION

mailto:support@picarro.com
mailto:sales@picarro.com
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11.2.1 Symptoms of a Clogged Filter
Filters can become clogged with continual use.

If liquid water is sucked into the inlet line, it may clog the filter and impede the flow (usually 
for a few days) until it evaporates.

Some symptoms of a clogged filter are:
 l The analyzer pressure is low
 l Low flow into the analyzer, causing unusual measurements
 l Response time is slower than usual

11.2.2 Solutions for Water Incursion
Do NOT turn off the analyzer when a filter is wet or replace a wet filter. Liquid water in the 
filter can cause condensation on the optics if the analyzer is allowed to cool when the filter is 
wet.
 l Dry the filter by running Clean Dry Air (CDA) through the analyzer. If the analyzer functions 

normally after drying, a filter replacement is not necessary.
 l If drying the filter does not solve the problem, replace the filter.

11.2.3 Required Parts and Tools
 l S3266 PI/SI5000 User Maintenance Kit
 l 9/16" and 11/16" open-end wrenches
 l Flathead screwdriver for releasing captive screws (if needed).

11.2.4 Pressure Inlet Port Particulate Filter Replacement
1. Shut down the analyzer by following 5.2 Shutdown , and move the analyzer to a clean 

work environment.

2. Release the captive screws and slide the filter assembly out of the analyzer filter bay. 
There may be some resistance as the filter is removed. This is due to the frictional 
resistance of the male quick-disconnect O-rings within the female receptacle.
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Removable Inlet Bulkhead

Captive Screws

Pressure Inlet

Removing Filter

Figure 57 - Pressure Inlet Port

3. The following figure shows the pressure inlet port filter assembly after removal. It is not 
necessary to remove the hose from the barbed inlet port.

Barbed pressure Inlet Port

Compression Nut

Male Quick Disconnect

Captive Screw (2 ea.)

Figure 58 - Pressure Inlet Filter — Removed
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4. Remove the old filter from the bulkhead assembly by loosening the compression nut. 
Remove the ferrules and discard.

Figure 59 - Removing Filter from Pressure Inlet Bulkhead

5. Remove the male quick-disconnect from the filter outlet by loosening the compression 
nut. Remove the ferrules and discard.

Figure 60 - Filter Removed from Pressure Inlet Bulkhead

6. Install the new ferrules onto the bulkhead compression fitting.

7. Attach a new filter to the bulkhead compression fitting.

Ensure the flow direction arrow on the filter is pointing away from the bulkhead 
compression fitting. Also ensure the tube and ferrules are fully seated into the filter fitting 
before fully tightening the nut.

8. Tighten the nut on the fitting until the final bit of thread is just showing past the nut.
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Figure 61 - Tightening the Filter Fittings

9. Install the new ferrules onto the quick disconnect fitting.

10. Reinstall the male quick disconnect to the new filter. Ensure the tube and ferrules are fully 
seated into the filter fitting before fully tightening the nut.

11. Tighten the nut on the fitting until the final bit of thread is just showing past the nut (Figure 
61).

12. Slide the completed assembly into the analyzer filter bay and secure the plate by 
tightening the captive screws.

When the filter assembly is about half an inch from the analyzer chassis, you will 
meet resistance as the male quick-disconnect enters its receptacle. You will need to 
firmly push it inward to fully seat the assembly. Then the captive screws can be 
tightened.

11.2.5 CPU Fan
The analyzer CPU fan is user-replaceable and is available per the following service kit:

CPU Fan for MI990 Motherboards

 l S3267: PI5000 CPU Fan Replacement Kit. Includes the S3263 (CPU Fan) and required 
tools for replacement.

11.2.6 A2000 Pump Rebuild Kit
The pump rebuild kit is the only component not currently sold as part of a preventive 
maintenance kit because the replacement frequency is not strictly annual (frequency 
depends on pump usage). 

NOTE
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The A2000 pump diaphragms and valves are user-replaceable. Use the following link to 
order rebuild kits and to find the instructional video and supporting maintenance document.
 l Pump Rebuild Kit: Used with SI2xxx, G2xxx analyzers (except Flight and Flux analyzers)

S2009 Rebuild Kit for A2000 Vacuum Pump – If viewing this manual as a paper hard copy, 
enter the following URL in your browser:

http://store.picarro.com/For-Analyzer/Pump/Rebuild-kit-for-Picarro-A2000-vacuum-
pump.html

11.3   Cleaning and Decontamination
Clean the outside of the analyzer with a clean dry cloth. Users should never access or clean 
the inside of a Picarro analyzer. For decontamination, run clean dry air (CDA) through the 
analyzer. If the analyzer does not decontaminate after running CDA for several hours, contact 
Picarro.

http://store.picarro.com/For-Analyzer/Pump/Rebuild-kit-for-Picarro-A2000-vacuum-pump.html
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12 Transportation and Storage
If the analyzer is transported or stored, use the following procedure to prepare and repack it 
into the original packaging.

When shipping or relocating the analyzer, it is important to protect it from mechanical 
shocks. Failure to do so can compromise its performance. When shipping the analyzer, 
use its original packaging only.

12.1   Shutdown and Preparation

A flow of clean, relatively dry gas should always be directed to the instrument for several 
minutes prior to shutting down. Trapping a high-moisture content gas sample in the 
cavity can cause condensation damage to the mirrors as the instrument cools from its 
operating temperature. See , for specific shutdown instructions for your model analyzer.

1. Click on the Quit button located on the left side of the Data Viewer window.

2. A window displays prompting the user to confirm the shutdown. Click Yes to continue 
the shutdown process.

Figure 62 - Stop Data Acquisition/Shutdown

3. Confirm the level of water vapor prior to shutdown. Click No, if the analyzer was dried 
before shutdown. Click Yes, if the analyzer requires dry gas to reduce the moisture 
content.

CAUTION

CAUTION
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Figure 63 - Reduce Moisture Content/Shutdown

Once confirmed, the analyzer software and hardware will turn off.

4. Manually turn off the pumps and dry gas (if used).

5. Disconnect all tubing and electrical connections from the analyzer.

6. To prevent contamination and possible damage to the connector threads, place 
protective caps on all gas connections.

12.2   Packing
1. Place the analyzer in a plastic bag with a package of desiccant.  Seal the bags with tape. 

If shipping the pump, do the same for it.

2. Pack the analyzer and pump in the original shipping containers ensuring that all the foam 
pieces are in place to protect the analyzer during shipping.
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A Setup Tools and Communication

A.1   Analyzer Settings and Tools
The Analyzer Setup Tools is accessed by using the Picarro Launch Pad and Settings button. 
These set of tools allow the user to configure data file saving details, including which data 
elements are written to data files, digital data output (via serial port or TCP/IP), and optionally 
configured electrical interface for additional measurement monitoring.

You must be logged in as a technician or administrator to access the Analyzer Setup 
Tools under Settings.

The settings of the Setup Tool are explained in the next pages in brief. A more in-depth 
description of the material is provided in the subsequent sections. If you have any questions 
about the Setup Tool, please contact Picarro or refer to Picarro Community for further 
details: https://www.picarro.com/support/community.

Figure 64 - Analyzer Setup Tools

NOTE

https://www.picarro.com/support/community
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Before running any of the setup tools, the instrument software must be stopped. From 
the CRDS Data Viewer, select the Quit button and click Yes when prompted to stop data 
acquisition. The Setup Tool options are now active.

A.1.1 Serial Port
The Serial Port menu is accessible from the  Menu and displays the configurations of COM1 
(used for Command Interface, query-based data output) and COM2 (used for Data 
Streaming). Users need to set the COM port protocol by using the Serial Port Configuration 
feature located from the Picarro Launch Pad, Config, and selecting the Serial Port button.

Figure 65 - Serial Port Settings

Configure the ASCII serial port by setting the Data Out and Command Interface parameters 
that are used for RS-232 serial communication.

The following options are provided:
 l Port — Indicates the desired communication port.
 l Baudrate — Specifies the rate at which bits are transmitted.
 l Data Bits — Specifies the number of data bits to transmit.
 l Stop Bits — Specifies the number of bits used to indicate the end of a byte.
 l Parity — Indicates the type of parity checking.
 l Enable Serial Port — Enables or disables the communication port specified in the Port 

field.

NOTE
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After making changes, select Save to apply the changes or Undo to revert to the previous 
configuration. Click OK to close the window.

A.1.2 Port Manager
The Port Manager allows you to control digital data output/input by using the serial port or 
TCP/IP.

Figure 66 - Serial/Socket Port Manager Settings

The following options are available within the Port Manager menu. Note /dev/ttyS* is a 
naming convention for serial ports on Linux. /dev/ttyS0 indicates the first serial port (COM1), 
/dev/ttyS1 suggests the second (COM2), and so on.
 l Data Streaming — The port you want your data to stream through. 
 l Valve Sequencer MPV (Multi Position Valve) — The port you want to connect your MPV. 
 l Command Interface — The port you want to connect your command-line interface. 

Make sure there are no COM port conflicts before clicking Save.

After making changes, select Save to put these changes into effect and click OK to close the 
window.

A.1.3 Command Interface — Specifying Digital Data Output
The Command Interface allows you to specify the data elements that are sent by using COM 
port/TCP (specified in the Port Manager).
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Figure 67 - Command Interface Settings

Two types of data can be specified here:

Output Data Source:
 l Datalog_User
 l DataLog_User_Sync (PI5131-i saves 3-seconds of synchronized output of prescribed 

data)

Output Data Columns:
 l The data columns are output in the order they are prescribed. The Command Interface 

enables an external device to send a set of predetermined commands to a Picarro 
analyzer. The analyzer returns data or metadata based on the command received.

After making the appropriate changes, click Save to put changes into effect and then OK to 
close the window.

A.1.4 Serial Communication Protocol
The Serial Port menu is accessible from the Config menu and displays the configurations of 
COM1 (used for Command Interface, query-based data output) and COM2 (used for Data 
Streaming).

Set the logging computer to use the same COM port protocol. The data listed can be 
modified for desired output.
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 l Baud rate: number of bit transfers per second
 l Data Bits: number of data bits in a communication packet, or a single byte transfer
 l Stop Bits: number of bits used to signal the end of a communication packet
 l Parity: sets the parity bit to Even, Odd, Mark, Space, or None

The Command Interface enables query-based data communication through COM1. For the 
PI5131-i, the default data list and serial port settings are defined in:

/home/picarro/I2000/AppConfig/Config/CommandInterface/CommandInterface.ini

meas_label = N2O, d15Nalpha, d15Nbeta, d18O, co2, ValveMask, EtalonTemp, WlmTemp, 
CavityTemp, CavityPressure, Laser1Temp, Laser1Current, LaserBaseplateTemp, 
BoxPressure, InletValve, OutletValve, DasTemp, ChillerTemp

[SERIALINTERFACE]  
port = /dev/ttyS0 #COM1
baudrate = 19200  
bytesize = 8  
parity = 'N'  
stopbits = 1  
timeout = 1  
xonxoff = 0  
rtscts = 0  

Output Frequency: The system outputs data when it receives a command on COM1 via 
RS232.

Example data output from using input: _MEAS_GETCONCEX and _MEAS_
GETBUFFERFIRST

Figure 68 - Example Data Output

A.1.5 Data Streaming— Specifying Digital Data Output
The Data Streaming menu allows you to specify the data elements that you want to send by 
using COM port (specified from the Port Manager).
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Figure 69 - Data Streaming Settings

Two types of data can be specified here:

Output Data Source:
 l Datalog_User
 l DataLog_User_Sync (relevant only for Flux G2311-f analyzers)

Output Data Columns:
 l The data columns are output in the order they are checked, e.g., H2O, comes before CO2. 

Command Interface enables an external device to send a set of predetermined 
commands to a Picarro analyzer. The Picarro returns data or meta-data on the basis of 
the command received.

Data Streaming outputs data continuously, whereas the Command Interface needs 
commands to output data.

After making the appropriate edits, click Save to put changes into effect and then OK to 
close the window.

NOTE
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A.1.6 Data Streaming Protocol
The Data Manager controls data streaming through the serial port, typically COM2. Once 
enabled, the specified data will be streamed through the designated COM port.

/home/picarro/I2000/AppConfig/Config/DataManager/DataManager_JEDS.ini

[SERIALOUTPUT]  
#PollChar = "x"  
Enable = True # Disable when this COM2 is used for other control.
Port = /dev/ttyS1 #COM2
Baud = 19200  
DataBits = 8  
StopBits = 1  
Parity = N  
...  

The default list for PI5131-i is as following. User may edit the list for desired output.

Format ="%15.2f %10.4f %10.4f %10.4f %10.4f %10.4f %10.4f %10.4f %10.4f %10.4f 
%10.4f %10.4f %10.4f %10.4f %10.4f %10.4f\r\n"

#time,N2O,d15Nalpha,d15Nbeta,d18O,co2,ValveMask,EtalonTemp,WlmTemp,CavityTemp
,CavityPressure,Laser1Temp,Laser1Current,LaserBaseplateTemp,BoxPressure,InletValve,
OutletValve,DasTemp,ChillerTemp

Output Frequency:

About 2 seconds.

An example of this data streaming output is as follows:

* COM3 is the COM port on logging PC.

Figure 70 - Example Data Streaming Output

A.1.7 Data Logger
The Data Logger allows the user to configure various data file saving details, including which 
data elements are written to data files.
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Figure 71 - Data Logger Setup Settings

The following data file options can be specified:
 l Data Columns — Controls which data elements are written to data files.
 l Hours of Each Log File — Controls the size of each data document.
 l Enable Mailbox Archiving — Enables archiving of data in the mailbox folder:

/home/picarro/I2000/Log/Archive/DataLog_Mailbox
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 l Archived Directory Structure — Specifies part of naming convention for data documents.
 l Total User Log Storage Size (GB) — Specifies the size of storage allowed for User Data 

(Recent Data).
 l Mode — Changes the way the analyzer fits and displays data in the data viewer on the 

basis of gas matrix, species reported, precision, and dynamic range.

After making the appropriate edits, click Save to put changes into effect and then OK to 
close the window.

A.2   Serial Communication
The analyzer supports an RS-232 physical command interface, which can be used to control 
the instrument and to retrieve concentration data. Not all features of the instrument are 
available on the serial interface.

For details on using the serial command interface, please see the Picarro Analyzer Remote 
Interface Programming Guide.

This command set may also be used across a TCP/IP interface through an Ethernet 
connection. Please contact Picarro for further details if needed.

A.2.1 NTP
The NTP section controls querying the Internet time servers using the SNTP protocol 
(RFC4330) and the resetting of the clock on the host computer. If the section is not present, 
time synchronization is not carried out. The keys Server1, Server2, etc., are used to specify 
the URLs of the time servers. If the UpdateClock key is set to “true,” the offset is applied to 
the host clock. Otherwise, the offset is recorded, but the host clock is not changed.

A.2.2 Email
The EMAIL section controls the sending of the data files as e-mail attachments. If the section 
is not present, e-mail messages are not sent. The key Directory specifies the directory that 
contains the data files. When the program is run, files in this directory are sent to the 
specified recipients and the files are deleted. To avoid problems with incomplete files, 
programs that place files into this directory should do so using an atomic operation, such as 
a rename. The Server key is set to the name of an RFC2821- compliant SMTP server that 
sends the e-mail messages.

The From key is the e-mail address from which the messages are sent. Note that some 
SMTP servers check that the source is permitted to send email while others allow any name 
in this field. The collection of e-mail addresses to which copies of the e-mail is sent is 
specified by the keys To1, To2, etc. The Subject key is used to fill the subject field in the 
email header and may be set to any string. Depending on the SMTP server, it may be 

NOTE

https://www.picarro.com/environmental/remote_interface_programming_guide_400063_reva
https://www.picarro.com/environmental/remote_interface_programming_guide_400063_reva
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necessary to use authentication before e-mails can be sent, as described in RFC2554. If 
such authentication is not needed, the key UseAuthentication is set to false. If this key is set 
to true, two additional keys Username and Password must also be specified for the e-mail 
account. 
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B  Alarm Status
ALARM_STATUS is a data column output by the instrument to warn the user when the 
instrument measures a gas that could produce data that falls outside of the operational 
range of the instrument. Falling outside of the operational range of the analyzer can cause 
the instrument to perform with a lack of precision, accuracy, or data rate. ALARM_STATUS is 
a flag nominally set to 0 when measuring ordinary ambient air and can be set to a number 
corresponding to a binary mask of a specific alarm.

The following table provides the alarm status bit assignments.

Table 11 - Alarm Status Bit Assignment

Bit 7 6 5 4 3 2 1

Alarm    
LaserBase
plateTemp

Box
Pressure

Cavity 
Pressure

WlmTemp [N2O]

Nominal    
27 # ± 0.1
Degree C

800 ± 1
Torr

75 ± 0.05

Torr
40.0 OC

< 1500 
ppb

# Some hot operated lasers may be set to higher laser base-plate temperature.

For each decimal, the ALARM_STATUS reading converts to binary and uses the above table 
to identify the detailed alarm as single or a combination. See the following examples.

Table 12 - Alarm Status Definitions

ALARM_STATUS Binary Mask Alarm Definition

0 0000000 All alarms cleared; analyzer is in normal operation.

1 0000001 N2O concentration is over 1500 ppb.

6 0000110 Cavity Pressure and WlmTemp are out of range.



C Data Log Columns

114 PN 40-0141, REV A PI5131-i User Manual

C  Data Log Columns
The following table describes all columns contained in the data log. The data log provides a 
complete set that includes all outputs produced by the analyzer and  the data logs described 
in Chapter 8, File Management and found in:

 /home/picarro/I2000/Log/Archive/YYYY-MM-DD/DataLog_User/

Table 13 - Data Log Columns

Data Key Units Definition

ALARM_STATUS Unitless Alarm status bit mask (see B  Alarm Status)

ALARM_WORD_0 Unitless Alarm status bit mask (see B  Alarm Status)

AmbientTemp °C
Temperature on Sensors board inside 
Coolbox

BoxPressure Torr Coolbox pressure reading

BoxPressureLock Unitless Status of coolbox pressure locking in range 

CavityPressure Torr Sample pressure in cavity

CavityTemp °C Averaged temperature of cavity body

CavityTemp1 °C Cavity temperature #1 (by front cavity mirror)

CavityTemp2 °C Cavity temperature #2 (between #1, #3)

CavityTemp3 °C Cavity temperature #3 (between #2, #4)

CavityTemp4 °C Cavity temperature #4 (by rear cavity mirror)

ChillerTemp °C Coolant temperature in TEC cooler block

CoolBoxHeatsink1Temp °C Front TEC heatsink temperature in coolbox

CoolBoxHeatsink2 Temp °C Rear TEC heatsink temperature in coolbox

CoolBoxPriTec Digital unit TEC signal for Coolbox Temperature Control

CoolBoxTec Digital unit TEC signal for Coolbox Temperature Control

DasTemp °C
Temperature sensor on DAS – PCBA, ~ +6 
offset to environmental temperature

DetectorAdc Unitless Baseline ADC signal from detector
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Data Key Units Definition

Etalon1 Digital unit Etalon #1 Signal (WLM)

Etalon2 Digital unit Etalon #2 Signal (WLM)

EtalonTemp °C Etalon Temperature

FDC_ALARM NA  

FRAC_DAYS_SINCE_
JAN1

Days Days since January 1, 1970

FRAC_HRS_SINCE_JAN1 Hours Hours since January 1, 1970

FanState NA  

INST_STATUS Unitless Instrument status bit flag

InletValve Digital unit
Inlet valve current signal for coolbox pressure 
control

JULIAN_DAYS seconds Time assigned since January 1, 4713 BC

LED_STATE Digital unit LED state for front panel

Laser1Current Digital unit Laser current signal sent to Laser

Laser1Tec Digital unit TEC signal for laser temperature control

Laser1Temp °C Laser temperature

LaserBaseplateTec Digital unit
TEC signal for LaserBasePlate Temperature 
Control

LaserBaseplateTemp °C Temperature of LaserBasePlate

MPVPosition unitless Multi-port valve state selected

N2O ppb N2O concentration reading in gas stream

N2O_100s ppb
N2O concentration reading in gas stream 
with 100s averaging

OutletValve Digital unit
Outlet valve current signal for cavity pressure 
control

Ratio1 Digital unit Ratio of Etalon1/Reference 1 (WLM)
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Data Key Units Definition

Ratio2 Digital unit Ratio of Etalon2/Reference 2 (WLM)

RecalibrateFlag unitless Calibration Flag by PZT jumps

Reference1 Digital unit Reference  #1 Signal (WLM)

Reference2 Digital unit Reference  #2 Signal (WLM)

SchemeTable unitless Spectrum Scheme Table

SchemeVersion unitless Spectrum Scheme Version

SpectrumID Unitless
Number assigned to measurement of 
species. 170 for PI5131-i.

ValveMask Unitless Binary valve mask of triggered solenoid valve

WlmTemp °C Wavelength Monitor (WLM) Temperature

adjust1 cm-1 Virtual laser 1 frequency shift by spectrum fit

adjust2 cm-1 Virtual laser 1 frequency shift by spectrum fit

base1a ppb/cm Base lose in VL#1 spectral fit region.

base1b ppb/cm Base lose in VL#2 spectral fit region.

co2 ppm
CO2 concentration with all corrections (low 
precision, for N2O interference correction 
use)

co2_TC ppm Thermal Corrected co2_raw

co2_raw ppm
Raw CO2 concentration reading in gas 
stream

d15N per_mil Average of d15Nalpha and d15Nbeta

d15Nalpha per_mil
Delta value of alpha-N2O (14N15N16O) in gas 
stream 

d15Nalpha_100s per_mil
Delta value of alpha-N2O with 100s 
averaging

d15Nbeta per_mil
Delta value of beta-N2O (15N14N16O) in gas 
stream
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Data Key Units Definition

d15Nbeta_100s per_mil Delta value of beta-N2O with 100s averaging

d18O per_mil
Delta value of 18O-N2O (14N14N18O) in gas 
stream

d18O_100s per_mil Delta value of 18O-N2O with 100s averaging

dm_latency Seconds Time for data to move through Datamanager

fitBackground ppb/cm
Averaged detector background to last raw 
ringdown traces, 4x

fit_time Seconds Duration to fit data to model

fsr_base1/4/5/6 ppb/cm
Baselines for N2O peaks: N2O, alpha, beta, 
O18

fsr_peak1/4/5/6 ppb/cm
Raw peak heights for N2O peaks: N2O, 
alpha, beta, O18

fsr_peak4/5/6_TC ppb/cm
Thermal corrected peak heights for N2O 
peaks: alpha, beta, O18

fsr_peak1/4/5/6_spec ppb/cm
TC and interferences corrected peak heights 
for N2O peaks

fsr_residuals1 (ppb/cm)2 Spectrum fit residual in N2O peak region

fsr_residualsN (ppb/cm)2
Spectrum fit residual in alpha-beta N2O peak 
region

fsr_residualsO (ppb/cm)2 Spectrum fit residual in O18-N2O peak region

fsr_shiftN cm-1 Frequency shift in alpha-beta N2O peak 
region

fsr_shiftO cm-1 Frequency shift in O18-N2O peak region

fsr_str1/4/5/6 unitless unit
Peak strengths for N2O peaks: N2O, alpha, 
beta, O18

fsr_y1 cm-1 Peak width of N2O peak, nominally as 
2.944@75Torr.

interval seconds Duration for one-point measurement
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Data Key Units Definition

max_fitter_latency seconds Maximal delay in spectrum fit

n2o_conc_raw ppb Raw N2O concentration

ngroups1/2 Unitless
Number of groups for spectra scanned with 
virtual laser #1 / #2

ntopper Unitless Number of points on beta-N2O peak top

numpoints Unitless
Number of ringdowns in spectra for one 
measurement

peak1a/b ppb/cm Peak heights of N2O doublets

peak_height ppb/cm Peak height of beta-N2O

peak40 ppb/cm Peak absorption of 13CO2 feature

peak50 ppb/cm Peak absorption of CO feature

peak_height ppb/cm Peak height of CO absorption peak

pzt1/2 Digital unit PZT average value for virtual laser #1 / #2

pzt1/2_adjust Digital unit PZT adjustment after each measurement

pzt1/2_delta Digital unit PZT gaps to last PZT offsets

pzt1/2_offset Digital unit Current PZT offset

pzt_per_fsr Digital unit
PZT sensitivity to cover one cavity free-
spectrum-range (fsr)

shift1/2 cm-1 Frequency shift in spectra scanned with 
virtual laser #1 / #2  

spect_duration Seconds Duration to collect spectrum

spect_latency Seconds Duration to send spectrum

str1a/b Unitless Peak strengths of N2O doublet

time Seconds Current time in EPOCH format

timestamp milliseconds Current time, (time*1000 + 62135596800000)
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Data Key Units Definition

tipstd ppb/cm
Loss standard derivation of points at beta-
N2O peak top

tiptop ppb/cm
Loss standard derivation of points at beta-
N2O peak top

vy1a/b cm-1 Linewidth of N2O peaks of doublet

wlm1/2_offset cm-1 WLM offsets to compensate frequency shifts
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D  Enabling/Disabling Data Output
The instrument allows for customization of the data output. Several data outputs can be 
enabled and disabled. Follow the instructions below to customize the data output.

1. Back up the following .ini file. This is useful if recovery of the original file is needed.

2. Modify the applications section as shown below. Adding # in front of the highlighted lines 
disables the application load; removing the # enables the application. Avoid any random 
mistyping or errors in this file.

3. Restart the computer to make the changes effective.

The .ini file resides in the following directory:

/home/picarro/I2000/AppConfig/Config/Supervisor/supervisorEXE_JEDS_lct.ini

[Applications]  
EventManager = 50000
Driver = 50010
Archiver  = 50060
RDFreqConverter = 50015
SpectrumCollector = 50075
Fitter = 50180
MeasSystem = 50070
DataManager  = 50160
SampleManager = 50080
InstMgr = 50110
QuickGui = # 50220
DataLogger = 50090
#Controller = 50050
BackupSupervisor =
FileEraserSimplified =
SQLiteServer =
   
CommandInterface = 50120 # COM#1 by default, lower port of right-bottom of rear panel
ValveSequencer = 50200 # COM#2 by default, upper port of right-bottom of rear panel
4to20Server = 50290 # COM#4 by default, on motherboard
ModbusServer =
……  
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E Analog Current Signal Output
Four channels of 4-20 mA current analog output are available on the back of the analyzer. 

Figure 72 - 4–20 mA Output with Terminal Connector

E.1   Conversion
Conversion from current readings to measurement value:

Measurement = Min + [ I(reading, mA) – I0 (4 mA) ] / 16 (mA) * (Max- Min)

For example, channel#0 reading of 6.735 mA indicates:

N2O (ppb) = 0 + (6.735-4.0) / 16 * (2000.0-0.0) = 341.875.

Channel#3 reading of 7.805 mA indicates:

dO18 (per_mil) = 0 + (7.805-4.0) / 16 * (100.0-(-100.0)) = 47.56

Table 14 - Signal Output Settings

  Iout0 Iout1 Iout2 Iout3

Monitoring N2O d15Nalpha d15Nbeta dO18

Units ppb per_mil per_mil per_mil

Min 0.0 -100.0 -100.0 -100.0

Max 2000.0 100.0 100.0 100.0

E.2   Connecting the 4–20mA Signal Output
To connect to the output:

1. Using your fingers, pull the 4–20 mA terminal connector straight back away from the 
analyzer.
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Figure 73 - Removing the Terminal Connector

2. Use a small slotted screwdriver to loosen the retaining screw for the desired terminal.

Figure 74 - Terminal Connector Retaining Screws

3. Insert the stripped end of the wire into the terminal.

4. Tighten the retaining screw.

5. Repeat for each desired terminal.

6. Slide the terminal connector back onto the analyzer with the retaining screws facing 
down; there should be a soft click when the connector is set into its proper position.

If shielding is desired, connect the drain wire of the shielded cable to the ground lug 
on the back panel. Do not connect the shield to the ground pins of the 4–20 mA 
connector. Connect only one end of the shielded cable to the ground lug to avoid 
ground loops.

E.3   Power Requirements
The 4-20 mA analog current signal output requires an additional user supplied power 
supply for operation. See the following diagram for more information.

NOTE
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Figure 75 - 4-20 mA Power Requirements
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F Data File Viewer

F.1   Quick Start Guide
The following sections introduce the user to all possible functionalities of the Data File Viewer 
in detail. This section describes the most common, simple use case.

The Data File Viewer software allows the user to concatenate multiple one-hour files into one 
larger file, enabling the user to observe trends over several days of measurements.

1. To start, translate the UserData files from DAT to H5. The Batch Convert option (B) 
allows user s to select any folder containing instrument data from a given day.

Figure 76 - Batch Convert DAT to H5 – Navigation

2. In the source folder there are now copies of the original files translated into the H5 format.

3. From File menu select Concatenate H5 Files (C) to combine the H5 files into a time 
series. Take care to select exactly the same folder in the file viewer window.

4. In the Select Variables window, click All to move over all variables for concatenation. If 
concatenating large records, the user can instead select only a few variables by clicking 
the variable name on the left dialogue, and clicking the double arrow button. Confirm by 
clicking OK.
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Figure 77 - Selecting Variables for Concatenation

5. The user will then be asked to confirm the file name for the concatenated data. The 
default location is the parent folder for the selected day, and the filename by default 
describes the time span of the measurements within. Successful concatenation is 
indicated by the filename automatically being displayed in the main data file viewer 
window as shown in the following figure.

Figure 78 - Concatenated Output .h5 Filename
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You can concatenate several days into one larger file, either by following steps 1-3 
for selected folders, or by copying all their DAT files into a new folder and performing 
steps 1-5 just once.

6. With the file now opened, the user can select how many Time Series to display on the 
screen.

Figure 79 - Time Series Selection Options

7. In the new window that displays, select the variables from the Var Name dropdown on 
the right of each plot. Deselect Autoscale y if the data stream has a large amount of 
variability in the Y-axis.

8. Please read the following sections to learn more about features of the Data File Viewer.

F.2   Data File Viewer Overview
The Picarro Data File Viewer software is located from the Picarro Launch Pad,  Home menu. 
This software allows you to graph and to conduct statistical analysis of the raw data. 
Additional functions include Allan Variance plot and quadratic or polynomial fittings. The 
Picarro Data File Viewer includes two main menus: File and New.

NOTE
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Figure 80 - Picarro Data File Viewer – File and New Menus

F.2.1 File Menu
This section describes the functions available from the Data File Viewer File menu.

Open File

File > Open File: Opens a Picarro data file (HDF5 format) for data analysis and visualization. 
After opening the data file, you can create a new time series plot. Refer to F.2.2 New — Time 
Series Plot for more information.

Load Config

File > Load Config: Loads a configuration file (ini format) to restore parameters of a 
workplace. Refer to F.3.1 Save Configuration for more information.

Unpack Zip File

File > Unpack Zip File: Use to concatenate all H5 files inside the zip file into a single H5 file. 
Refer to  Concatenate H5 Files below for details.
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Concatenate H5 Files

File > Concatenate H5 Files: Use to concatenate multiple files and zip archives of H5 files 
into a single H5 file. Navigate to the desired folder or use the Define Date Range button to 
specify a date range of files to concatenate. (see  Define Date Range).

After selecting the path of the data files, Data File Viewer will automatically search an H5 file 
in the specified zip/folder and look for all available variables in the H5 file. The variables are 
then listed in the Select Variables window in the left panel, and users can use the >> button 
to move variables to the right panel for concatenation.

Figure 81 - Select Variable Form

This screenshot is for example only. The species selections shown on your analyzer may 
vary.

Define Date Range

Data File Viewer can search data files within the desired date range and then concatenate 
such files into an H5 file.

NOTE
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By default, TimeZone is set to your local time zone. However, if data were taken elsewhere, 
select the time zone where data was taken.

Select File > Concatenate H5 Files, and click Define Date Range to specify the desired date 
range as shown in the following figure.

Figure 82 - Define Date Range Dialog

Picarro software saves data in directories that are named by the creation year, month, and 
day. Select Data files are saved in directory trees named by date and time option if the target 
folder has this file structure. This allows Data File Viewer to only search folders within the 
desired date range, which can substantially reduce processing time.
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Figure 83 - File Structure of Data File Viewer

To save processing time, Data File Viewer does not open data files, but only determines 
data acquisition time based on the file name.

Do not define a time range for data files whose names have been changed.

Data File Viewer does not concatenate data files exactly within the defined time range. 
This is because the time extracted from file name is different from the data acquisition 
time. To not miss data points, Data File Viewer expands the specified time range, so the 
resulting data set normally has a wider time range than the user specification.

NOTE

CAUTION

NOTE
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Convert DAT to H5

Select File > Convert DAT to H5 to convert a file in DAT format to HDF5 format. These 
formats are described below:
 l DAT Format: DAT files accepted by DatViewer store tabular data (numbers and text) in 

plain text.
 o Each line of the file is a data record. Each record consists of one or more fields 

separated by whitespaces.
 o The first line of the data file indicates column names.
 o There must be a field “EPOCH_TIME” to store the acquisition epoch time (expressed 

as seconds since Jan 1, 1970) of the data. Otherwise, the first and second fields must 
be “DATE” and “TIME”. The “DATE” field must have the format “mm/dd/yyyy” or “yyyy-
mm-dd”, and the “TIME” field must have the format “HH:MM:SS(.sss)” where (.sss) is 
an optional fraction of seconds.

 l HDF5 Format: HDF5 is a data model, library, and file format for storing and managing 
data. (See the HDF5 Home Page on the HDF Group website https://www.hdfgroup.org/ 
for more information.) When converting DAT to HDF5 format, Data File Viewer creates a 
table named “results” to the contained data.

Convert H5 to DAT

Select File > Convert H5 to DAT to convert a file in a HDF5 format to DAT. These formats are 
described in Convert DAT to H5.

Data File Viewer does not concatenate data files exactly within the defined time range. 
This is because the time extracted from file name is different from the data acquisition 
time. To not miss data points, Data File Viewer expands the specified time range.

Interpolation

Interpolation describes the method for constructing data points with a range of a discrete set 
of known data points. Select File > Interpolation to perform interpolation on a time grid with a 
constant interval.

Block Average

Select File > Block Average to divide a data set into small blocks based on a user-defined 
block size. The average is calculated for data in each block, and the results are saved in a 
new H5 file.

NOTE

https://www.hdfgroup.org/
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The specified block size must be greater than the average data interval.

Because the data interval is normally not a constant (unless interpolation is performed), 
fluctuations in the data interval will affect block averaging if the block size is comparable to 
the average data interval.

F.2.2 New — Time Series Plot
You can specify to include create time-series plots with one, two, or three frames. New plots 
display in the Time Series Viewer.

This screenshot is for example only. The species shown on your analyzer may vary.

Figure 84 - Time Series Viewer

NOTE

NOTE
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The next section describes the options available on the Time Series Viewer menu bar. Refer 
to The Time Series Viewer Canvas or more information on the Time Series Viewer UI features 
and options.

F.3   Time Series Viewer Menus
The Time Series Viewer form includes the following menus:

Figure 85 - Time Series Viewer Menus

Use the File menu to save a configuration or take a screenshot.

Figure 86 - Time Series Viewer – File Menu

F.3.1 Save Configuration
Click File > Save Configuration to open the Feature Capture form. With this form, you can 
save figure properties, expressions, filters, and other settings to a configuration file so that it 
can be easily loaded in the future.

Figure 87 - Time Series Viewer – Feature Capture
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If a feature is not captured, it will be omitted when the configuration file is loaded.

Depending on the features captured, loading a configuration file can have different effects. 
For example:
 l If all features are captured, a saved workplace is reproduced.
 l If a data file is not captured, saved parameters are applied to the data file in memory.
 l If an expression is not captured, plots will not be transformed.
 l  If X (Y) range is not captured, figures are auto-scaled on the x (y) axis.

F.3.2 Take Screenshot
Use File > Take ScreenShot to take a screenshot of the Time Series Viewer and save it as a 
.png to a specified file.

F.3.3 Time Series Viewer Analysis Menu
Use the Analysis menu to calculate statistics, generate a histogram, and to plot correlations 
and Allan Standard deviations.

Figure 88 - Time Series Viewer – Analysis Menu

Statistics

Use Analysis > Statistics to calculate mean, standard deviation, and peak to peak for all 
plots in the current window.

Histogram

Use Analysis > Histogram to generate a histogram of data.

CAUTION
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Figure 89 -  Histogram Window 

Histogram Window Features

 l Red Line — A Gaussian function fitted to the histogram. Fitting results of μ and σ are 
shown in the top-left corner of the plot.

 l Bin — Specifies the number of intervals that the range of values is divided into.
 l Normalized — When selected, the sum of the histograms is normalized to 1.
 l Save data — Saves histogram data to a CSV file.
 l Save image — Saves the histogram image as a JPEG/PNG/PDF file.

Correlation Plot

Use Analysis > Correlation Plot to plot Y-axis data in one frame versus that in the other. This 
can be used when two or more frames exist in the current Time Series Plot window. See the  
Correlation/XY Plot for details.

Allan Standard Deviation Plot

Use Analysis > Allan Standard Deviation Plot to create an Allan Standard Deviation plot 
(versus a standard deviation plot) for data in the current window. See Allan Variance 
Wikipedia page for more information.

F.3.4 Time Series Viewer View Menu
Use the View menu to view X-axis information in date-time, minute, or hour format.

https://en.wikipedia.org/wiki/Allan_variance
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Figure 90 - Time Series Viewer – View Menu

When switching from Datetime to Minute or Hour, the X-axis data is subtracted from the 
earliest point shown in the panel and then converted to the desired unit.

F.3.5 The Time Series Viewer Canvas
The Time Series Viewer canvas is comprised of interactive graphs and a variety of 
configuration options.

This screenshot is for example only. The species shown on your analyzer may vary.

NOTE

NOTE
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Figure 91 - Time Series Viewer Canvas

Mouse Options and Graph Transform

The following mouse actions can be used in the canvas graphs:
 l Left-click and drag — Zooms into the selected area of the plot.
 l Left-click and drag with the SHIFT key down — Pans the plot.
 l Left-click and drag with CTRL key down — Zooms out from the plot.
 l Left-click and drag with ALT key down — Stretches the plot.
 l Right-click — Opens an additional menu. Refer to the Right-click menu below in the next 

section.

Right-click Menu

Right-clicking on the canvas opens a pop-up menu:
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Figure 92 - Canvas Right-click Pop-up Menu

The following options are available from the right-click menu.
 l Export Image — Exports the current plot as a jpeg, png, or pdf file.
 l Export Data in Current View — Exports only date/time and the selected variable in the 

current view to an HDF5 or CSV file.
 l Export All Data in Current Time Range — Exports all variable columns of the selected 

dataset in the current time range to an HDF5 file. Refer to Concatenate H5 Files on Page 
81 for more information.

 l Edit Plot Properties — Opens the Image Editor form where the following options can be 
specified.

Image Editor

Figure 93 - Time Series Viewer Image Editor

Image Editor Form Options:
 l Title — Edits the title of the plot.
 l Line — Specifies the line pattern of the plot. If None is selected, the data points will be 

plotted without connecting lines.
 l Marker — Specifies the marker type to indicate data points. If None is selected, data 

points will not be shown.
 l x-Axis — Min and Max: Specifies the minimum and maximum date range for the X-axis.
 l x[0] — Sets the earliest time of the dataset as the minimum of the X-axis.
 l Time zone — Sets the time zone for date/time variables. This defaults to the local time 

zone.
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 l Label — Specify labels for the X-axis and the Y-axis.
 l y-Axis — Min and Max: Specifies the minimum and maximum of data displayed on the Y-

axis.

Dataset Name and Var Name

An HDF5 file can store one or more tables. Each of these tables is called a Dataset. A table 
can contain one or more columns. Each column is called a variable (Var).

Use the Dataset name drop down to select the dataset that is used for this time series graph. 
Use the Var name drop down to select the column in the dataset to use in the graph.

Figure 94 - Time Series Viewer Dataset Options

Autoscale Y

When the Autoscale Y option is selected, the Time Series Viewer will autoscale on the Y-axis 
to make sure that all data within the range of the X axis is displayed. This feature can make it 
hard to see small signals when large signals blow the Y axis out, so it is often advisable to 
deselect this check box for dynamic or spikey datasets.

Average

If Block is selected, a block average is calculated when you click the Do average button. 
Otherwise, a moving average is calculated.

For a block average, Size specifies block size in unit of a minute. For a moving average, Size 
specifies subset size in unit of data points.

Averaging is performed after the Filter and Expression are performed.

REMINDER
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Mean, Std Dev, and Peak to Peak

The Mean, Std dev (Standard deviation) and Peak to peak fields (Figure 94) provide all the 
statistical information of data in the current view.

Correlation/XY Plot

The Correlation/XY Plot window includes three menu items: File, Fitting and Analysis. For 
details about the File menu, see F.3.1 Save Configuration and F.3.2 Take Screenshot. Fitting 
and Analyst are described below.

The canvas in this plot is interactive. For details about the plot canvas, see F.3.5 The 
Time Series Viewer Canvas.

Figure 95 - Correlation XY Plot

F.3.6 Fitting Menu
The Fitting menu includes three options which are described below.

REMINDER
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Figure 96 - Fitting Menu

Fitting allows you to specify one of four fitting methods to include in the Correlation/XY plot:
 l Linear Fit — Specifies to fit to linear function:

y = c1x + c0
 l Quadratic Fit — Specifies to fit to quadratic function:

y = c2x2 + c1x + c0
 l Polynomial Fit — Specifies to fit polynomial function of degree n:

y = Σcnxn
 l Curve Fit — Specifies to use non-linear least squares to fit an arbitrary function to data.

F.3.7 Analysis Menu
The Analysis menu has two options: Integration and Statistics.

Figure 97 - Analysis Menu

 l Integration — Calculates area under the curve using the composite trapezoidal rule.
 l Statistics — Calculates mean, standard deviation, and peak to peak for data in the current 

view.

After applying any of the above Analysis options, the results, statistics, or fitting function with 
coefficients are displayed in the lower portion of the Correlation Plot window.

Figure 98 - Results of Quadratic Fitting
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G Setting up Contained Exhaust Flow
The A2000 vacuum pump is shipped with a noise dampener attached to the exhaust port. 
When a hazardous gas exhaust line from the pump is needed, it requires replacing the noise 
dampener with an adapter that allows a 1/4” OD exhaust tubing connection. Use the 
following instructions when installing a pump exhaust line.

Exhaust Port with Noise Dampener Vacuum Port

Figure 99 - A2000 Pump Vacuum and Exhaust Ports

G.1   Tools and Parts Required
 l Long flathead screwdriver (6” x 5/16” recommended) 
 l 9/16” open end wrench 
 l Swagelok ISO parallel thread adaptor 1/4"-1/8” SS-400-1-2RS (Picarro PN 22928)
 l Swagelok gasket SS-2-RS-2V (Picarro PN 22929)
 l 1/4" tubing and stainless-steel ferrule set
 l Snoop leak-detection fluid or similar soap solution

G.2   Directions
1. Remove the noise dampener fitting from the bottom of the pump using a long flathead 

screwdriver (Figure 100). 

1 2
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Noise Dampener 

Figure 100 - Pump Noise Dampener Removal

2. Slide the adapter gasket PN 22929 onto the adapter fitting PN 22928 (Figure 101), screw 
it into the pump exhaust port, and then tighten it 1/4 turn using a 9/16” wrench. 

3. Remove the Swagelok nut and ferules from the adapter fitting to ensure their orientation 
is as shown below, then loosely reattach to the adapter.

4. Slide the 1/4” exhaust tubing into the Swagelok nut and ferules until the tubing is fully 
seated, then using a 9/16" wrench, tighten the nut approximately seven flats (420 
degrees).

Adapter Fitting PN 22928

Adapter Gasket PN 22929

Figure 101 - Pump Exhaust Line Adapter Fittings

5. With the pump running on room air, apply Snoop leak detection fluid to the installed 
exhaust components to confirm that the system is leak tight. Instructions for leak testing 
using Snoop can be found in this video: https://vimeo.com/375518688 (go to time 5:20 
in the video)

1

1

2

https://vimeo.com/375518688
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H External Valve Sequencer 

H.1   Introduction
The Picarro analyzer can control two types of valves:
 l Rotary Selector Valve — Digitally controlled valve used to send selected flow from one of 

many inputs (up to 16) into the analyzer.
 l Solenoid Valves — DC voltage powered valve with normally open (NO) and normally 

closed (NC) positions. These can be 2-way or 3-way valves.

Both types of valves can be simultaneously controlled through a common software interface 
called the External Valve Sequencer (described in H.6 External Valve Sequencer Software 
Overview) which is available from the Tools menu on the GUI.

Picarro offers two rotary valve and two solenoid valve solutions:
 l A0311 — 16-Port Distribution Manifold.
 l A0311-S — 16-Port Distribution Manifold (Silco) which is optimized for use with sticky 

and reactive gases.
 l S3112 — 3-Way stainless steel solenoid valve with 1/4” fittings.
 l S3136 — 3-Way stainless steel solenoid valve with 1/8” fittings.

H.2   A0311 16-Port Distribution Manifold

H.2.1 Compatibility 
The A0311 (Figure 102) is broadly compatible with most Picarro analyzers except for those 
with known surface and chemical compatibility issues (such as the G2103, SI2103, SI2108, 
SI2104, SI2205, G2307, G2509, and PI2114).

H.2.2 Function
The A0311 and External Valve Sequencer GUI makes it easy to program the sequence and 
duration of sample intake from various attached sampling lines, flasks, or bags. The manifold 
is controlled using either the Picarro analyzer GUI or an external hand-pad (included with the 
A0311).

The A0311 samples up to 16 gas sources. During operation, the selected line is routed 
through the valve into the analyzer. The 15 lines that are not selected terminate in the valve.

For detailed instructions on integrating the A0311 with your analyzer, refer to the 16-Port 
Manifold, User Manual, Including A0311, A0311-S, A0310 (P/N 40-0038).

 

NOTE
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Figure 102 - A0311 – 16-port Distribution Manifold

H.3   A0311-S 16-Port Distribution Manifold (Silco)

H.3.1 Compatibility
The A0311-S (Figure 103) is broadly compatible with all Picarro analyzers but is optimized for 
use with sticky and reactive gases in the following platforms, nominally:
 l G2103, SI2103, SI2108, SI2104, SI2205, G2307, G2509, and PI2114

H.3.2 Function
For users who require faster response performance, the A0311-S is a 16-Port distribution 
manifold with a flow through valve for reduced memory effects. Designed to optimize 
response time in the presence of reactive gases, the A0311-S uses SilcoNert® coated 
components, PFA tubing, and an additional vacuum pump.

The sampling duration and sequence is easily programmed through the Picarro External 
Valve Sequencer GUI. This design is ideal for fast switching between different locations for 
specialty applications in semiconductor, pharmaceutical, environmental research, and other 
industries. 

For detailed instructions on integrating the A0311-S with your analyzer, refer to the 16-
Port Manifold, User Manual, Including A0311, A0311-S, A0310 (P/N 40-0038).

Figure 103 - A0311-S – 16-Port Sequencer – Fast Multiport Gas Sampler

NOTE
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H.4   Setting Up Solenoid Valves
The Valve Sequencer software can control up to six solenoid valves. Each valve should 
operate using 12 VDC with a maximum quiescent current of 500 mA. Most analyzers come 
with a valves cable that can be connected to the solenoid valves, and if not, one can be 
purchased by contacting support@picarro.com.

Be careful to avoid shorting the solenoid valve output pins, as this will blow the relays on 
the power board, requiring a replacement or repair.

The valve connector cable should be connected to the 15-pin connector at the lower left 
corner of the analyzer. There are six pairs of wires with connectors labeled V1, V2, … V6 with 
2-pin female Molex connectors (Molex #43020-0200) for connection to the solenoid valves. 
For valves wired with matching Molex connectors, connect V1 to the solenoid valve 1, V2 to 
solenoid valve 2, etc. Do not connect the solenoid valve to the analyzer ground – use only the 
provided electrical connectors.

H.5   Setting up a Rotary Selector Valve
The (null modem) 9-pin female connector cable should be attached to its corresponding 9-
pin male port (COM 2) on the analyzer. The other end of the cable connects to the 9-pin port 
on the A0311. Please note the 9-pin connector cable is not supplied with the instrument – 
only as part of the A0311 kit.

H.6   External Valve Sequencer Software Overview
The External Valve Sequencer software allows the user to define a sequence of (repeating) 
steps within which rotary valve positions and/or solenoid valve positions can be defined 
uniquely at each step.

H.6.1 Opening the Sequencer
From the CRDS Data Viewer, Users dropdown menu login using your username and 
password. Then, from the Tools drop-down menu, select Show Valve Sequencer GUI. The 
Picarro valve sequencer window displays, but typically sitting behind the main GUI. Hitting 
alt-tab brings the Valve Sequencer GUI to the front.

CAUTION

mailto:support@picarro.com
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Figure 104 - Launching the Valve Sequencer GUI

H.6.2 Valve Sequencer UI Menus
The sequencer GUI provides the following dropdown menu options.

Figure 105 - Valve Sequencer UI Dropdown Menus
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The following figure provides functional descriptions of the External Valve Sequencer UI.

Current step and valve state status panel (when sequencer is running)

Sequencer configuration controls

Figure 106 - External Valve Sequencer UI

The Current Step #, the Remaining Time (min), and the Current Valve State are shown in the 
topmost row of the valve sequencer command window. The duration of each step is set in 
decimal minutes; for example, 15 seconds would be entered in as 0.25 minutes.

While a sequence is inactive, Current Step # will typically read “0”. Once the user has 
selected Start Sequence from the Action menu, or once the user clicks Apply from the GUI, 
the Current Step value will change to 1, corresponding to the first step defined below it, and 
will continue through the steps, returning to Step 1 once the last step is completed. 

If a user wishes to perform a set of steps only once, they may set a final step with a very long 
duration, or wait until the sequence is finished, and at the end of the last step, click Stop 
Sequence from the Action menu.

1

2
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Under Action, the Go to First Step menu item restarts the sequence from step 1. When the 
first step in the sequence starts, the “Current Step” value will change to “1”. This will begin 
the sequence if the sequence is currently active.

H.7   Programming and Saving a Valve Sequence
Each “step” in the sequence can be used to set the rotary valve to a given position or activate 
selected solenoid valves for a set period. Multiple steps can be carried out in sequential 
order to switch between different gas sources, flush out a manifold, or to perform other gas 
handling operations. 

1. Create the number of desired steps in the sequence by clicking the up/down arrow for 
Total Steps.

2. For each step, select the box for each solenoid valve to be opened. The check mark in 
the Current Valve State window indicates a solenoid valve is set to its “normally closed” 
value in the case of a 3-way, or to its “open” value in the case of a 2-way on/off valve. The 
positions from left to right correspond to solenoid valves V1 to V6.

3. The rotary selector valve position can be set in the column labeled Rot. Valve Code. 
Enter the number that corresponds to the desired valve position. A value of 1 in this field 
corresponds to position 1 on the rotary valve. Only one rotary position can be selected 
per step. 

4. The upper right box, Current Rot. Valve Code, displays the current value while a 
sequence is active. It should be white if a rotary valve is connected, turned on, and 
detected by the software. If the box is grayed out, the rotary valve is not detected (if so, 
consult your rotary valve manual).

5. For each step, set the desired Duration. This is determined by the value entered in the 
Duration (min) field, where the duration of the step is in minutes. If duration values are set 
to <0.1 minutes, they may not be carried out accurately.

6. The Valve Code column (not used with the rotary valves) is a configuration-dependent, 
read-only display field that shows the total state of that particular step in a numerical 
binary sum of form 2 (Valve Number -1). When powered, the following valve values are 
produced, and then added together for the final Valve Code.

  Valve 1 Powered = 2(Valve number-1) = 2(1-1) = 1

  Valve 2 Powered = 2(Valve number-1) = 2(2-1)= 2

  Valve 3 Powered = 2(Valve number-1) = 2(3-1)= 4

  Valve 4 Powered = 2(Valve number-1) = 2(4-1) = 8

  Valve 5 Powered = 2(Valve number-1) = 2(5-1)= 16

  Valve 6 Powered = 2(Valve number-1) = 2(6-1)= 32
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The maximum displayable value is 63 (=1+2+4+8+16+32), when valves 1-6 are all 
powered. All other combinations of valves are unique binary sum values which denote 
the specific combination of any of the six valves.

This Valve Code value active at a particular point in time can be shown in the main 
Picarro software GUI as SolenoidValves or sometimes ValveMask (this may require 
going to Settings > Service Mode > password picarro). The Rotary valve code can be 
displayed as MPVPosition.

Figure 107 - Example 15 Minute Sequence

Above is a 15 minute valve sequence. It opens 5 minutes for each solenoid valve (#1, 
#2 and #3), and each of rotary valve (#4, #5 and #6).

7. Once the valve sequence has been programmed, it can be saved by selecting Save Valve 
Sequence File under the File menu (Figure 105). The sequence may be saved with any 
name the user chooses. 

NOTE
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H.8   Loading and Running a Saved Sequence

H.8.1 Loading a Saved Sequence
1. Under the File menu, select Load Valve Sequence. 

All the sequence files are in:

/home/picarro/I2000/InstrConfig/ValveSequencer/Name of the Sequence File

2. To load an existing valve sequence file, select the desired sequence name. 

If the user has been running a different sequence from the one that was loaded, the user 
needs to press Run Next Step to initialize the newly selected sequence, or alternately go 
to File > Go To First Step and Start Sequencer.

H.8.2 Running a Sequence
1. Under the Action menu, select Start Sequencer.

This selection will change to Stop Sequencer once the sequence starts. (The sequencer 
should be activated if it was disabled, but not necessarily to change from one sequence 
to another.) The sequence will repeat itself indefinitely until disabled or the software is 
exited. 

2. Once the sequencer is running, the user can select Hide Sequencer Interface under the 
Action menu; the sequence will continue to run even with the UI hidden, and will 
automatically continue if the instrument ever loses power from the wall and restarts after 
power is restored. (However, the timing of the sequence will be offset relative to the 
intended cadence.) 

3. To bring the sequencer interface back into view, from the main Picarro GUI, go to Tools > 
Show/hide Valve Sequencer again.

H.8.3 Skipping Steps or Advancing to a Particular Step
If desired, the valve sequence can be forwarded to the next step of the sequence by clicking 
the Run Next Step button on the UI. To jump to a particular step, increment the Run Step # 
field and click Apply.

H.8.4 Stopping the Sequencer 
1. Under the Action menu, select Stop Sequencer. 

This will leave all valves in their current state. In some situations, it is convenient to 
program the last step in the sequence to be a safe or default valve state. 

2. Should the user need to put the solenoid or rotary valves into a safe/default state, the 
sequencer can be advanced to the last step using the Run Next Step button. 
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H.8.5 Resetting Valves
Under the Action menu, selecting Reset All Valves will deactivate/reset all valves to their 
default state. 

H.8.6 Valve Sequencer Data Records
For each individual measurement the analyzer makes, the valve codes and rotary valve 
positions corresponding to the valve states at that point in time are saved alongside the 
concentration data as long as the variable is selected from the Picarro Launch Pad, Settings, 
Data Logger Setup, Data Columns window.

If the desired variable is not available, select Service Mode and then select the value from the 
variables that populate into the Data Columns window and click Save. Note the changes will 
take effect after the software restarts.

Figure 108 - Data Logger Service Mode
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If no solenoid valves are present, the codes will be recorded regardless of whether a 
valve is connected.

If no steps are defined, and no sequence is active, these values will display 0.

H.9   Scheduling a Sequence
Users may schedule a sequence to start at a particular time in the future, often at the top of 
the hour, or at midnight for a recurring sequence with an hourly or daily cadence. The 
Schedule Sequence button is typically greyed out when the user shows the valve sequencer 
because the start time has passed. To begin a run in the future, select the desired date under 
Start Date, and the desired time under Start Time. When both values are in the future, the 
Schedule Sequence button will become active, and the user may click it. When the 
scheduled time arrives, the sequence will start automatically.

NOTE

NOTE
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I Analyzer Calibration (Initial)
Picarro strongly recommends calibrating your isotopic CRDS analyzer upon receiving it from 
the factory. For N2O isotope measurements, you should calibrate the three quantities: δ15Nα, 
δ15Nβ, and δ18O, using appropriate standards. There is no need to calibrate δ15N separately, 
as it is calculated as the average of δ15Nα and δ15Nβ.

To obtain meaningful delta values from an instrument, it is essential to first calibrate it using 
standards with known delta values. When calibrating Picarro analyzers, a linear 
transformation is established, defined by a slope and an offset. Upon delivery, the user 
calibration settings are initially set to a slope of 1 and an offset of 0. Users can adjust these 
calibration settings (refer to section 6.2.3 for details). While new user calibrations may lead to 
changes in both the slope and offset, we recommend adjusting only the offset during more 
frequent calibration sessions.

When applying a new slope calibration, it is important for the user to consider their 
experimental uncertainty. For instance, if the slope calibration changes from 1 to 0.95, this 
alteration may not indicate an actual change in the system's linearity; it could merely reflect 
experimental uncertainty. If your calibration data indicates a new slope greater than 1.05 or 
less than 0.95, please repeat your standard measurements. In most cases, such significant 
changes in slope are due to uncertainty and do not signify a problem with the analyzer’s 
linearity. If your analyzer continues to show a large change in slope after this, please contact 
Picarro Customer Support before implementing a new calibration.

To perform a calibration, the user simply needs to introduce the first calibration standard into 
the analyzer for a period long enough to allow the analyzer to yield a stable measurement of 
that sample.

It is essential to plot the analyzer's reported values on the horizontal axis and the certified 
values of the standards on the vertical axis. The slope and intercept of the best-fit line 
through these points are the two values used to calibrate the analyzer. Since Picarro gas 
analyzers exhibit a high degree of linearity, only three calibration standards are needed to 
calibrate each gas or isotopic species. Two points are required to define the calibration line, 
and a third intermediate point is used for verification.

The specific value of each calibration standard is not critically important, as long as the 
collection of standards covers the range of values that the analyzer will typically measure. 
While it is not necessary to use more than three standards, additional standards can provide 
a tighter constraint on the linear calibration coefficients.

I.1   Offline Corrections
To ensure accurate isotope readings, post-processing must account for the following 
effects:
 l Analyzer drift
 l Variations in N2O concentration
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 l Variations in the gas matrix (especially O2 concentration)
 l Spectroscopic interferences from other gases (e.g., CH4, CO)

I.2   Drift
All isotope analyzers experience drift over time. For the PI5131-i, the drift specification is less 
than 3 ‰ over a 24-hour period for δ15N, δ15Nα, δ15Nβ, and δ18O. Most applications require 
drift corrections at least daily, and in some cases, hourly. The frequency of calibration 
depends on the specific application.

I.3   Concentration Dependence
All isotope analyzers that use optical absorption measurements will demonstrate a 
concentration dependence in the isotope readings. Users should characterize and correct 
for this concentration dependence in their analyzers.

I.4   Matrix Effects
The analyzer is designed specifically for measuring N2O isotopes in ambient or air-like 
conditions. Data must be corrected to account for variations in O2 levels within the percent 
range. High concentrations of CH4 or CO may lead to spectroscopic interference, 
necessitating correction.

I.5   Secondary Standards
To verify linearity and correct for the dependence of N2O concentration, utilize working 
standards that cover the isotopic and concentration ranges of your samples. Site-specific 
N2O isotopic standards can be challenging to obtain. However, two pure N2O standards, 
USGS51 and USGS52, are available from the U.S. Geological Survey (USGS), and N2O-in-air 
standards can be procured from Air Liquide.

A detailed calibration workflow that addresses these corrections is provided in Harris et al. 
(2019).

Drying the airstream is unnecessary because the PI5131-i features a built-in Nafion 
dryer. If the CRDS analyzer is connected to a front-end interface, such as the Sage Gas 
Autosampler or the Small Sample Introduction Module, make sure that both standards 
and samples are introduced using the same pathway to ensure consistency, adhering to 
the same treatment principles.

Reference
Harris, S., Liisberg, J., Xia, L., Wei, J., Zeyer, K., Yu, L., Barthel, M., Wolf, B., Kelly, B., Cendón, D., Blunier, T., Six, 
J., & Mohn, J. (2019). N2O isotopocule measurements using laser spectroscopy: analyzer characterization and 
intercomparison. Atmospheric Measurement Techniques Discussions, 1–84.

NOTE
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J Remote Analyzer Access
Remote access allows you to access and control the analyzer from another computer from 
anywhere, enabling troubleshooting, file access, and remote work. This guide covers 
TeamViewer® and RealVNC®which are third-party applications.

The analyzer comes with TeamViewer and RealVNC preinstalled. However, you must 
install the application you plan to use on the device you want to control from.

J.1   TeamViewer
The TeamViewer application allows remote viewing of the analyzer and data access.

J.1.1 Locating ID and Password
TeamViewer requires and ID and password to establish a remote connection. Use the 
following procedure to locate the ID and password of the remote computer (analyzer).

1. On the analyzer, open TeamViewer. If you are not logged in, the ID and password are 
displayed in the main interface.

ID and Password

Figure 109 - TeamViewer Main Interface

2. When logged in, the ID and Password displays in the Remote Support window.

NOTE

1
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ID and Password

Figure 110 - TeamViewer Remote Device ID & Password

3. Note the ID and Password of the remote computer (analyzer) for use in the next step.

J.1.2 Connecting to Remote Computer (Analyzer)
Now that you have the ID and the password, use the following procedure to connect to the 
remote computer (analyzer).

1. If not already installed, download and install TeamViewer on the device you wan to 
connect from.

2. Open TeamViewer Remote and sign in.

3. Go to the Remote Support menu on the left-hand side of the interface.

4. Within the Provide Support section, enter the remote device's ID and click Connect.

ID field and Connect button

Figure 111 - TeamViewer Entering Remote Device ID & Password

1

1

https://www.teamviewer.com/
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5. Now enter the remote device's password and click Connect.

You successfully connected your remote device (analyzer).

J.2   RealVNC
The RealVNC application allows remote viewing only. Data access is not available. Follow 
the procedure to connect to the remote computer (analyzer) using RealVNC.

1. If not already installed, download and install RealVNC Viewer on the device you wan to 
connect from.

2. Open RealVNC Viewer and sign in.

3. From the toolbar select File and New Connection.

4. Enter the IP address of the remote computer (analyzer) and a name if desired. Click OK.

Enter IP address and description

Figure 112 - RealVNC  Properties

5. From the main menu, double click on the Computer to establish a remote connection.

1

http://www.realvnc.com/
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Remote connection (analyzer)

Figure 113 - RealVNC Remote Connection Entries

6. From the Authentication window enter picarro for the password and select Remember 
password. Click OK.

Enter and save password

Figure 114 - RealVNC Authentication

You successfully connected your remote device (analyzer).

1

1
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K Linux Keys and Commands
This section describes the Linux Ubuntu shortcut keys and terminal commands. Each entry 
specifies its function, syntax, and usage context. The following keys and commands are 
available for reference and application.

K.1   Keyboard Shortcuts
The following table provides useful shortcut keys.

Table 15 - Shortcut Keys

Keys Description

Alt + Tab Switches between running applications

Alt + F2 Run command

Alt + Space Shows current window operations

Alt + F7 Moves current windows with keyboard

Ctrl + Alt + Up/Down Switches between virtual workspaces

Super + Drag Moves window

Super + Up Maximize window

Super + Down Undo maximize window

Super + D Show desktop

Screenshots (/home/picarro/pictures)

PrintScreen Captures entire screen

Alt + PrintScreen Captures current window

Screen Recordings (/home/picarro/videos)

Alt + Shift + Ctrl + R Enables recording

K.2   Command Terminator
Options for opening the Linux command Terminator:
 l Alt + F2, type gnome-terminal and enter.
 l On desktop open space, right-click and select Open in Terminal.
 l From Picarro Launch Pad, Administration tab, select Launch Shell.
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K.3   Commands
The following table provides useful shell line commands.

Linux commands are case sensitive. The command must be exact for the system to 
recognize and execute it.

Table 16 - Linux Shell Line Commands

Keys Description

> picarroMenu Opens Picarro OS utilities.

>lsb_release –a
Prints certain Linux Standard Base (LSB) and 
distribution information.

>xrandr
Lists all available display output interfaces and its 
state (DP, DVI, HDMI).

>xrandr --output DP1 --auto
Enables DPI with auto setting. DPI is the video 
streaming port.

>xrandr --output eDP1 --off
Disables eDPI, the virtual display generated when no 
monitor is connected.

> ps –ax | grep python Lists running Python processes.

> kill ### Terminates running process.

> nautilus Opens file manager, {Ctrl+L ...shows address bar}.

>caja Opens file manager, {Ctrl+L ...shows address bar}.

>gedit Opens text editor.

>ip -br a Brief IP report.

>du -sh Summarizes file space usage in current directory.

>df -h Report file system disk space usage.

Remote Access

>teamviewer Opens TeamViewer

>anydesk Opens AnyDesk

NOTE
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L SDS for Koolance LIQ-702
A PDF copy of this SDS from Koolance is available at koolance.com.

If the specified coolant is unavailable, any 702 coolant may be used. For best results, 
blue or yellow is preferred. For more information, see Koolance 702 coolant.

See the following pages for the Koolance 702 Safety Data Sheet.

NOTE

https://koolance.com/files/products/manuals/Koolance_LIQ-702_SDS_(English).pdf
https://koolance.com/liquid-coolant-bottles
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M Introduction to Technology
Picarro analyzers use time-based, optical absorption spectroscopy of the target gases to 
determine concentration. They are based on wavelength-scanned cavity ring-down 
spectroscopy (WS-CRDS), a technology in which light re-circulates many times through the 
sample, creating a very long effective path length for the light to interact with the sample, 
thus, enabling excellent detection sensitivity in a compact and rugged instrument. 

The Picarro analyzer is comprised of two modules:
 l The analyzer contains the spectrometer, sample chamber, and a computer with a hard 

drive to store and analyze data. The single analyzer module controls the operation of the 
system and converts spectroscopic measurements into gas concentration data.

 l The external vacuum pump draws the sample gas through the instrument.

M.1   Cavity Ring-Down Spectroscopy (CRDS)
Nearly every small gas-phase molecule (e.g., CO2, H2O, H2S, NH3) and isotopologue (e.g., 
H2

18O, 13CO2, 15N14N16O) uniquely absorb specific wavelengths of near-infrared light. The 
strength of the light absorption is related to the concentration of a molecule in a sample and 
the distance that light travels through the sample, called the path length. 

Conventional infrared spectrometers are typically only sensitive enough to detect trace 
gases at levels in the part-per-million. Cavity Ring-Down Spectroscopy (CRDS), on the other 
hand, is one thousand to one million more times sensitive. 

The increased sensitivity of CRDS is due to the design of the sample cavity and the time-
based measurement. In the cavity, a series of mirrors reflects the infrared light through the 
sample, increasing the path length. For a Picarro cavity of only 25 cm in length, the effective 
path length of the cavity can be over 20 kilometers.

In Picarro analyzers, light from a single-frequency laser enters a cavity where three mirrors 
reflect the laser light as seen in Figure 1. The light enters through the mirror closest to the 
laser, bounces off the angled mirror in the lower right corner of the cavity, travels to the 
hemispherical mirror at the top of the cavity, bounces toward the mirror in the lower left 
corner of the cavity, and then returns to the first mirror. This motion becomes a continuous 
traveling light wave, which is represented by the dark orange path in Figure 1.
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Figure 115 - Schematic of the Picarro CRDS analyzer cavity

When the laser is on, the cavity quickly fills with laser light. A small amount of the laser light is 
transmitted through the mirror closest to the photodetector, which turns the incident light 
into a signal that is directly proportional to the light intensity in the cavity.

When the photodetector signal reaches a threshold level (in a few tens of microseconds), the 
laser is turned off. The light contained within the cavity continues to bounce between the 
mirrors (about 40,000 times). Since the mirrors have slightly less than 100% reflectivity 
(99.999%), the light inside the cavity steadily leaks out of the cavity. The intensity of the light 
reaching the detector decreases, falling exponentially until it reaches zero. This decay, or 
"ring-down,” is measured in real time by the photodetector.

M.2   Relating Ring-Down Time to Absorption Intensity
The time it takes to ring-down is inversely related to the total optical loss in the cavity, 
including the strength of molecular absorption at a given wavelength of light. For an empty 
cavity, the time it takes for the intensity to decrease by a given percent is determined solely 
by the reflectivity of the mirrors. A cavity containing gas that absorbs light will have a shorter 
ring-down time than an empty cavity. As the light circulates in a cavity with a gas sample, the 
molecular absorption by the gas results in a decrease of the light intensity.

Determining absorption intensity at a specific wavelength requires comparing the ring-down 
time of an empty cavity to the ring-down time of a cavity that contains gas. A cavity can be 
empty if it contains no gas; it will also appear empty if the molecules of the sample inside the 
cavity do not interact with the specific wavelength of light.
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Picarro instruments gather measurements from an “empty” cavity by switching the light to 
wavelengths that are not absorbed by the target molecules. The analyzer subsequently 
measures ring-down times at wavelengths that are absorbed by the target gas. The analyzer 
automatically and continuously compares these two types of ring-down times, and the 
software uses those comparisons to calculate absorption intensities.

Figure 116 - Light intensity as a function of time in a CRDS system

M.3   Converting Absorption Intensity to Concentration
Plotting the absorbance at each measured wavelength generates an optical spectrum. This 
spectrum contains absorbance peaks that are unique to each molecule in the sample. The 
height of a particular absorption peak is proportional to the concentration of a molecule that 
generated the signal. 

The height of the peak is calculated by subtracting the maximal absorbance from the 
baseline absorbance. Figure 117 shows a plot of ideal optical spectra with a clean, uniform 
baseline on either side of the absorption peak.



M Introduction to Technology

182 PN 40-0141, REV A PI5131-i User Manual

Figure 117 - Absorption Spectral Curve

However, optical spectra often contain several absorption lines, nested closely together. A 
particular absorption peak may be visible between lines, but the absorption may not return to 
the baseline before it rises in response to another molecule. Picarro analyzers calculate the 
baseline underneath a poorly resolved peak by modeling the absorption peaks from other 
surrounding molecules and subtracting contributions from neighboring peaks to the 
absorption intensity. 

M.4   Spectral Precision and High Sensitivity Measurements
Picarro analyzers contain two features that provide high spectral precision:
 l Proprietary wavelength monitor (WLM) that measures the absolute laser wavelength to a 

precision that is a few orders of magnitude narrower than the spectral linewidth: Picarro’s 
patented WLM measures absolute laser wavelength to a precision more than 1,000 times 
narrower than the observed Doppler-broadened linewidth for small gas-phase molecules. 
The instruments lock the laser to the WLM, and then the monitor tunes to wavelengths 
known to be maximally and minimally absorbed by the target molecule. The result is 
closely clustered absorption intensities, measured at wavelengths just before peak 
absorption, at peak absorption, and just after peak absorption, as the absorbance returns 
to the baseline.

 l Precise temperature and pressure control in the sample cavity: Accurate absorption 
measurements at precisely known wavelengths account for little unless the temperature 
and pressure of the CRDS measurement cavity are known. The observed line intensity 
and shape depend on the temperature and pressure inside the sample cavity. Small 
temperature and pressure instabilities can result in large concentration errors due to 
fluctuating peak heights and baselines. To completely minimize instrument measurement 
drift, temperature and pressure must be actively stabilized to constant values. 



M Introduction to Technology

PI5131-i User Manual PN 40-0141, REV A 183

For precise temperature control, the sample cavity is surrounded by layers of thermally 
insulating material to provide a high degree of passive thermal stability. The cavity is further 
actively stabilized by means of a solid-state heating system locked to the output of a thermal 
sensor. This enables the temperature of the cavity to be within 20 mK of the set temperature. 

For precise pressure control, the cavity pressure is monitored using a high-linearity pressure 
transducer. The system computer uses this pressure data in a feedback loop to control 
proportional valves that adjust the inlet and outlet gas flow of the cavity. 
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N Limited Warranty
Limited Warranty for Picarro Products and Peripherals.  Picarro warrants that during the 
Warranty Period the Picarro Products and Peripherals will be free from substantial defects in 
material and workmanship under normal uses, and will substantially conform to Picarro’s 
published Specifications for the Product. “Specification" means the then current user guide, 
technical specification or other product documentation prepared by Picarro (and does not 
include marketing collateral).  This limited warranty extends only to the original end-user 
(“Customer”) of the Product.

Warranty Period.  The Warranty Period commences upon shipment of the Product and the 
Warranty Period continues for a period of 13 (thirteen) months (for shipments directly to 
customers) or 15 (fifteen) months (for shipments to a Picarro partner).

Warranty Remedies.  Customer's sole and exclusive remedy and the entire liability of Picarro 
and its suppliers under this limited warranty will be, at Picarro’s option, repair of the Product; 
or shipment of a replacement Product within the warranty period and according to Picarro’s 
replacement process; or a refund of the purchase price if the Product is returned to Picarro, 
freight and insurance prepaid. Picarro replacement parts used in Product replacement may 
be new or equivalent to new.

In the event Picarro repairs or replaces the Product under this warranty, then the Warranty 
Period will be extended for the longer of a) ninety (90) days, or b) the period of time during 
which Customer has been unable to use the Product based upon the date on which the 
Customer or partner first reported to Picarro the problem giving rise to the warranty claim.

As part of the Limited Warranty, during the Warranty Period Picarro may provide: (1) 
telephone and email technical support, including remote log-in capabilities during Picarro’s 
regular support hours and (2) software updates that Picarro generally makes available 
without additional cost. Picarro will provide all parts and services required to repair or 
replace the Product, provided that repairs will be performed remotely or at Picarro’s factory.  
Picarro reserves the right to use local, authorized partners to assist in providing warranty 
repairs and/or factory returns and End Customer will cooperate with such local partners.

Picarro's obligations hereunder are conditioned upon the return of the defective Product in 
accordance with Picarro’s then-current Return Material Authorization (RMA) procedures.  
Customer or partner will pay for shipping of the Product to Picarro, and following repair of the 
Product Picarro will pay for return shipment to the Customer or partner under Incoterm DDP. 
Any other costs of shipment will be Customer’s or partner’s responsibility. Customer must 
follow instructions provided by Picarro for packaging and shipping the Product.

Warranty Restrictions. The above Product warranty does not apply if the Product (a) has 
been altered, except by Picarro or by Customer with Picarro’s prior written approval, (b) has 
not been installed and used in accordance with Picarro’s Specification, (c) has been 
subjected to abnormal physical or electrical stress, abnormal environmental conditions, 
misuse, negligence, or accident; (d) is licensed for beta, evaluation, testing or demonstration 
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purposes; and (e) does not extend to recovery or replacement of any data from any medium.   
The Warranty Periods for spare parts, consumables and RMA repairs are not included in this 
document and are described under the Support Service Terms document.

Disclaimer:  Picarro disclaims all other warranties, either express or implied, including 
warranties of fitness for a particular purpose.  Except as set forth in this document, or as 
otherwise expressly agreed in writing by Picarro, there are no other warranties applicable to 
Picarro Products.



About Picarro         
Picarro is a leading provider of solutions to measure greenhouse gas (GHG) concentrations, trace 
gases, and stable isotopes across many scientific applications, along with the energy and utilities 
markets. Our patented Cavity Ring-Down Spectroscopy (CRDS) is at the heart of all Picarro instruments 
and solutions, enabling the detection of target molecules at part per billion or better resolution.

Product Support

Utilize Picarro support resources for product support. Join the Picarro community to ask 
questions and get answers, search the document library for datasheets and user manuals, 
download software, and purchase products and replacement parts. 

 
Access to online community forums and software downloads are available only for registered 
Picarro customers with login credentials. If you do not have an account, you can register by 
using the community and software download links below.

 

  Picarro Document Library
  Picarro Community (Forums)
  Picarro Software Downloads
  Picarro Literature (Scientific Resources)
  Picarro Web Store

Contact Picarro for questions regarding specific applications and additional information.

Picarro Customer Support (USA) Picarro Customer Support (International)

Email: support@picarro.com Email: support@picarro.com
Phone: +1 408 962 3991 Phone: +31 85 888 1650

https://www.picarro.com/support/documents
https://www.picarro.com/support/community
https://www.picarro.com/support/downloads
https://www.picarro.com/support/literature
https://store.picarro.com/
mailto:support@picarro.com
mailto:support@picarro.com
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